
Microsoft Offi ce PowerPoint 2007

Creating and Editing a 
Presentation1

Objectives
You will have mastered the material in this chapter when you can:

• Start and quit PowerPoint

• Describe the PowerPoint window

• Select a document theme

• Create a title slide and text slides 
with single- and multi-level 
bulleted lists

• Save a presentation

• Copy elements from one slide 
to another

• View a presentation in Slide 
Show view

• Open a presentation

• Display and print a presentation 
in grayscale

• Check spelling

• Use PowerPoint Help
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1 Creating and Editing a 
Presentation
What Is Microsoft Offi ce PowerPoint 2007?
Microsoft Offi ce PowerPoint 2007 is a complete presentation graphics program that 
allows you to produce professional-looking presentations (Figure 1–1). A PowerPoint 
presentation also is called a slide show.

PowerPoint contains several features to simplify creating a slide show. For example, 
the results-oriented user interface can boost productivity by making tasks and options 
readily accessible. Professionally designed standard layouts help you save time by format-
ting and creating content. You then can modify these layouts to create custom slides to fi t 
your specifi c needs. To make your presentation more impressive, you can add diagrams, 
tables, pictures, video, sound, and animation effects. Additional PowerPoint features 
include the following:

• Word processing — Create bulleted lists, combine words and images, fi nd and 
replace text, and use multiple fonts and type sizes.

• Outlining — Develop your presentation using an outline format. You also can 
import outlines from Microsoft Word or other word processing programs.

• Charting — Create and insert charts into your presentations and then add effects 
and chart elements.

• Drawing — Form and modify diagrams using shapes such as arcs, arrows, cubes, 
rectangles, stars, and triangles. Then apply Quick Styles to customize and add effects. 
Arrange these objects by sizing, scaling, and rotating.

• Inserting multimedia — Insert artwork and multimedia effects into your slide show. 
The Microsoft Clip Organizer contains hundreds of media fi les, including pictures, 
photos, sounds, and movies.

• Saving to the Web — Save presentations or parts of a presentation in HTML 
format so they can be viewed and manipulated using a browser. You can publish your 
slide show to the Internet or to an intranet.

• E-mailing — Send your entire slide show as an attachment to an e-mail message.
• Collaborating — Share your presentation with friends and coworkers. Ask them 

to review the slides and then insert comments that offer suggestions to enhance the 
presentation.

• Preparing delivery — Rehearse integrating PowerPoint slides into your speech by 
setting timings, using presentation tools, showing only selected slides in a presentation, 
and packaging the presentation for a CD.
This latest version of PowerPoint has many new features to increase your produc-

tivity. Graphics and other shape effects allow you to add glow, shadowing, 3-D effects, 
and other appealing visuals. Typography effects enhance the design’s impact. PowerPoint 
themes apply a consistent look to each graphic, font, and table color in an entire presen-
tation. Digital signatures enable you to verify that no one has altered your presentation 
since you created it, and the Document Inspector removes private data, such as comments 
and hidden text.
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PowerPoint gives you the fl exibility to make presentations using a projection device 
attached to a personal computer or using overhead transparencies. In addition, you can take 
advantage of the World Wide Web and run virtual presentations on the Internet. PowerPoint 
also can create paper printouts of the individual slides, outlines, and speaker notes.

Project — Presentation with Bulleted Lists
In Project 1, you will follow proper design guidelines and learn to use PowerPoint to 
create, save, and print the slides shown in Figures 1–1a through 1–1e on this page and the 
next. The objective is to produce a presentation, called A World Beneath the Waves, to 
help the Student Government Association (SGA) President, Dave Ehlin, promote the an-
nual spring break diving and snorkeling trip to Cabo San Lucas, Mexico. This slide show 
presents the highlights of this trip and promotes the included amenities, tour prices, and 
the inviting Pacifi c waters. Some of the text will have formatting and color enhancements. 
In addition, you will print handouts of your slides to distribute to students.

Project Planning
Guidlines

The process of developing a presentation that communicates specifi c information requires 
careful analysis and planning. As a starting point, establish why the presentation is needed. 
Next, analyze the intended audience for the presentation and their unique needs. Then, 
gather information about the topic and decide what to include in the presentation. Finally, 
determine the presentation design and style that will be most successful at delivering the 
message. Details of these guidelines are provided in Appendix A. In addition, each project in 
this book provides practical applications of these planning considerations.

(a) Slide 1 (Title Slide)

(c) Slide 3 (Multi-Level Bulleted List)
Figure 1–1

(b) Slide 2 (Single-Level 
Bulleted List)
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PowerPoint allows you to produce slides to use in an academic, business, or other envi-
ronment. One of the more common uses of these slides is to enhance an oral presentation. 
A speaker may desire to convey information, such as urging students to participate in a 
food drive, explaining fi rst aid, or describing the changes in an employee benefi t pack-
age. The PowerPoint slides should reinforce the speaker’s message and help the audience 
members retain the information presented. An accompanying handout gives audience 
members reference notes and review material after the presentation’s conclusion.

Overview
As you read this chapter, you will learn how to create the presentation shown in 

Figure 1–1 by performing these general tasks:

• Select an appropriate document theme.
• Enter titles and text on slides.
• Change the size, color, and style of text.
• View the presentation on your computer.
• Save the presentation so you can modify and view it at a later time.
• Print handouts of your slides.

General Project Guidelines
When creating a PowerPoint document, the actions you perform and decisions you make will 
affect the appearance and characteristics of the fi nished document. As you create a presentation 
such as the project shown in Figure 1–1, you should follow these general guidelines:

1. Find the appropriate theme. The overall appearance of a presentation signifi cantly 
affects its capability to communicate information clearly. The slides’ graphical appearance 
should support the presentation’s overall message. Colors, fonts, and layouts affect how 
audience members perceive and react to the slide content.

2. Choose words for each slide. Use the less is more principle. The less text, the more likely 
the slides will enhance your speech. Use the fewest words possible to make a point.

(continued)

Plan 
Ahead

(d) Slide 4 (Multi-Level Bulleted List) (e) Slide 5 (Closing Slide)

Figure 1–1 (continued)
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To Start PowerPoint

The following steps, which assume Windows is running, start PowerPoint based on a typical installation. You 
may need to ask your instructor how to start PowerPoint for your computer.

Figure 1–2

• Click the Start button on the 
Windows taskbar to display the 
Start menu.

• Point to All Programs on the Start 
menu to display the All Programs 
submenu.

• Point to Microsoft Offi ce on the All 
Programs submenu to 
display the Microsoft Offi ce 
submenu (Figure 1–2).

1

All Programs 
submenu

Microsoft Offi ce 
submenu

Microsoft Offi ce 
command

All Programs 
command

Microsoft Offi ce 
PowerPoint 2007 
command

Start button Windows 
taskbar

Windows displays 
commands on the 
Start menu above 
the Start button

Starting PowerPoint
If you are using a computer to step through the project in this chapter and you want 
your screen to match the fi gures in this book, you should change your screen’s resolution 
to 1024 � 768. For information about how to change a computer’s resolution, read 
Appendix E.

Decreasing Resolution
You may need to 
decrease your computer’s 
resolution if you know 
you are going to run your 
presentation on another 
computer that uses a 
lower resolution, such as 
800 � 600 or 640 � 480. 
This lower resolution, 
however, may affect 
the appearance of 
your slides.

B
T
W

Starting PowerPoint   PPT 5

Po
w

er
Po

in
t 

C
h

ap
te

r 
1

(continued)

3. Format specifi c elements of the text. Examples of how you can modify the appearance, 
or format, of text include changing its shape, size, color, and position on the slide.

4. Determine where to save the presentation. You can store a document permanently, or 
save it, on a variety of storage media including a hard disk, USB fl ash drive, or CD. You 
also can indicate a specifi c location on the storage media for saving the document.

When necessary, more specifi c details concerning the above guidelines are presented 
at appropriate points in the chapter. The chapter also will identify the actions performed 
and decisions made regarding these guidelines during the creation of the slides shown in 
Figure 1–1.

Plan 
Ahead
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Figure 1–3

• Click Microsoft Offi ce 
PowerPoint 2007 to 
start PowerPoint and 
display a new blank 
document in the 
PowerPoint window 
(Figure 1–3).

• If the PowerPoint 
window is not 
maximized, click the 
Maximize button next 
to the Close button on 
its title bar to maximize 
the window.

What is a maximized 
window?

A maximized window 
fi lls the entire screen. 
When you maximize a 
window, the Maximize 
button changes to a 
Restore Down button. 
When you restore a 
maximized window, 
the Restore Down 
button changes to a 
Maximize button.

 2

Q
&

A

The PowerPoint Window
The PowerPoint window consists of a variety of components to make your work more 
effi cient and documents more professional. These include the document window, Rib-
bon, Mini toolbar and shortcut menus, Quick Access Toolbar, and Offi ce Button. Some 
of these components are common to other Microsoft Offi ce 2007 programs; others are 
unique to PowerPoint.

PowerPoint Window
The basic unit of a PowerPoint presentation is a slide. A slide may contain text and 

objects, such as graphics, tables, charts, and drawings. Layouts are used to position this 
content on the slide. When you open a new presentation, the default Title Slide layout 
appears (Figure 1–4). The purpose of this layout is to introduce the presentation to the 
audience. PowerPoint includes eight other built-in standard layouts.

The default (preset) slide layouts are set up in landscape orientation, where the 
slide width is greater than its height. In landscape orientation, the slide size is preset to 
10 inches wide and 7.5 inches high when printed on a standard sheet of paper measuring 
11 inches wide and 8.5 inches high.

title bar

Close button

Normal view button 
is selected when you 
start PowerPoint 

Windows taskbar displays 
PowerPoint program 
button, indicating 
PowerPoint is running

title of blank document 
is Presentation1

Maximize button changed to a 
Restore Down button because 
window is maximized

Other Ways

1. Double-click PowerPoint 
icon on desktop, if one 
is present

2. Click Microsoft Offi ce 
PowerPoint 2007 on 
Start menu

Portrait Page 
Orientation
If your slide content 
is dominantly vertical, 
such as a skyscraper 
or a person, consider 
changing the slide 
layout to a portrait page 
orientation. To change 
the orientation, click the 
Slide Orientation button 
in the Page Setup group 
in the Design tab and 
then click the desired 
orientation. You can use 
both slide and portrait 
orientation in the same 
slide show.
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PLACEHOLDERS Placeholders are boxes with dotted or hatch-marked borders that are 
displayed when you create a new slide. All layouts except the Blank slide layout contain place-
holders. Depending on the particular slide layout selected, title and subtitle placeholders are 
displayed for the slide title and subtitle; a content text placeholder is displayed for text, art, or 
a table, chart, picture, graphic, or movie. The title slide in Figure 1–4 has two text placehold-
ers where you will type the main heading, or title, of a new slide and the subtitle.

MOUSE POINTER The mouse pointer becomes different shapes depending on the 
task you are performing in PowerPoint and the pointer’s location on the screen. The 
mouse pointer in Figure 1–4 is the shape of a block arrow.

SCROLL BAR You use the vertical scroll bar to display different slides in the document 
window. When you add a second slide to a presentation, this vertical scroll bar appears on 
the right side of the Slide pane. On the scroll bar, the position of the scroll box refl ects 
the location of the slide in the presentation that is displayed in the document window. A 
scroll arrow is located at each end of a scroll bar. To scroll through, or display different 
portions of the document in the document window, you can click a scroll arrow or drag 
the scroll box to move forward or backward through the presentation.

The Previous Slide button and the Next Slide button appear at the bottom of the vertical 
scroll bar. Click one of these buttons to advance through the slides backwards or forwards.

Figure 1–4

Slide pane

Notes pane

Slides tab Outline tab

Title Slide 
layout 

splitter bar

text 
placeholder

total number 
of slides

status bar

document 
theme identifi er

mouse pointer
Normal view is 
default view

Next Slide 
button

Previous Slide 
button

scroll bar

scroll box

scroll arrow

The PowerPoint window in Figure 1–4 contains placeholders, a mouse pointer, and 
a status bar. Other elements that may appear in the window are discussed later in this and 
subsequent chapters.

The PowerPoint Window   PPT 7
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The horizontal scroll bar also may appear. It is located on the bottom of the Slide pane 
and allows you to display a portion of the slide when the entire slide does not fi t on the screen.

STATUS BAR The status bar, located at the bottom of the document window above 
the Windows taskbar, presents information about the document, the progress of current 
tasks, and the status of certain commands and keys; it also provides controls for viewing 
the document. As you type text or perform certain commands, various indicators may 
appear on the status bar.

The left edge of the status bar in Figure 1–4 shows the current slide number 
followed by the total number of slides in the document and a document theme identi-
fi er. A document theme provides consistency in design and color throughout the entire 
presentation by setting the color scheme, font and font size, and layout of a presentation. 
Toward the right edge are buttons and controls you can use to change the view of a slide 
and adjust the size of the displayed document.

PowerPoint Views
The PowerPoint window display varies depending on the view. A view is the mode 

in which the presentation appears on the screen. PowerPoint has three main views: 
Normal, Slide Sorter, and Slide Show, and also Notes Page. The default view is Normal 
view, which is composed of three working areas that allow you to work on various aspects 
of a presentation simultaneously. The left side of the screen has a Tabs pane that consists 
of a Slides tab and an Outline tab that alternate between views of the presentation in a 
thumbnail, or miniature, view of the slides and an outline of the slide text. You can type 
the text of the presentation on the Outline tab and easily rearrange bulleted lists, para-
graphs, and individual slides. As you type, you can view this text in the Slide pane, which 
shows a large view of the current slide on the right side of the window. You also can enter 
text, graphics, animations, and hyperlinks directly in the Slide pane. The Notes pane at 
the bottom of the window is an area where you can type notes and additional information. 
This text can consist of notes to yourself or remarks to share with your audience. If you want 
to work with your notes in full page format, you can display them in Notes Page view.

In Normal view, you can adjust the width of the Slide pane by dragging the splitter 
bar and the height of the Notes pane by dragging the pane borders. After you have created 
at least two slides, scroll bars, scroll arrows, and scroll boxes will appear on the right edge 
of the window.

Ribbon
The Ribbon, located near the top of the PowerPoint window,  is the control center 

in PowerPoint (Figure 1–5a). The Ribbon provides easy, central access to the tasks you 
perform while creating a slide show. The Ribbon consists of tabs, groups, and commands. 
Each tab surrounds a collection of groups, and each group contains related commands.

Figure 1–5(a)

top-level tabs Home tab Ribbon 

groups 

Using the Notes Pane
As you create your 
presentation, type 
comments to yourself 
in the Notes pane. 
This material can be 
used as part of the 
spoken information you 
will share with your 
audience as you give 
your presentation. You 
can print these notes for 
yourself or to distribute 
to your audience.
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Figure 1–5(b)

When you start PowerPoint, the Ribbon displays seven top-level tabs: Home, 
Insert, Design, Animations, Slide Show, Review, and View. The Home tab, called the pri-
mary tab, contains the more frequently used commands. To display a different tab on the 
Ribbon, click the top-level tab. That is, to display the Insert tab, click Insert on the Rib-
bon. To return to the Home tab, click Home on the Ribbon. The tab currently displayed 
is called the active tab.

To display more of the document in the document window, some users prefer to 
minimize the Ribbon, which hides the groups on the Ribbon and displays only the top-
level tabs (Figure 1–5b). To use commands on a minimized Ribbon, click the top-level tab.

Each time you start PowerPoint, the Ribbon appears the same way it did the last 
time you used PowerPoint. The chapters in this book, however, begin with the Ribbon 
appearing as it did at the initial installation of the software. If you are stepping through 
this chapter on a computer and you want your Ribbon to match the fi gures in this book, 
read Appendix E.

In addition to the top-level tabs, PowerPoint displays other tabs, called contextual 
tabs, when you perform certain tasks or work with objects such as pictures or tables. If 
you insert a picture in a slide, for example, the Picture Tools tab and its related subordi-
nate Format tab appear (Figure 1–6). When you are fi nished working with the picture, the 
Picture Tools and Format tabs disappear from the Ribbon. PowerPoint determines when 
contextual tabs should appear and disappear based on tasks you perform. Some contextual 
tabs, such as the Chart Tools tab, have more than one related subordinate tab.

Minimizing the Ribbon
If you want to minimize 
the Ribbon, right-click 
the Ribbon and then click 
Minimize the Ribbon 
on the shortcut menu, 
double-click the active 
tab, or press CTRL+F1. 
To restore a minimized 
Ribbon, right-click the 
Ribbon and then click 
Minimize the Ribbon 
on the shortcut menu, 
double-click any top-level 
tab, or press CTRL+F1. 
To use commands on a 
minimized Ribbon, click 
the top-level tab.

B
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Figure 1–6

Commands on the Ribbon include buttons, boxes (text boxes, check boxes, etc.), 
and galleries (Figure 1–6). A gallery is a set of choices, often graphical, arranged in a grid 
or in a list. You can scroll through choices on an in-Ribbon gallery by clicking the gallery’s 
scroll arrows. Or, you can click a gallery’s More button to view more gallery options on 
the screen at a time. Some buttons and boxes have arrows that, when clicked, also display 
a gallery; others always cause a gallery to be displayed when clicked. Most galleries sup-
port live preview, which is a feature that allows you to point to a gallery choice and see its 
effect in the document - without actually selecting the choice (Figure 1–7).

top-level tabs minimized Ribbon 

in-Ribbon 
gallery

button
contextual 
tabs

button arrow Dialog Box Launcher

gallery scroll 
arrows
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Some commands on the Ribbon display an image to help you remember their 
function. When you point to a command on the Ribbon, all or part of the command 
glows in shades of yellow and orange, and an Enhanced ScreenTip appears on the screen. 
An Enhanced ScreenTip is an on-screen note that provides the name of the command, 
available keyboard shortcut(s), a description of the command, and sometimes instructions 
for how to obtain help about the command (Figure 1–8). Enhanced ScreenTips are more 
detailed than a typical ScreenTip, which usually only displays the name of the command.

Figure 1–8

Figure 1–7

as you move the 
mouse pointer 
from one gallery 
option to the next, 
PowerPoint shows 
a preview of the 
theme on the slide, 
so you can decide 
whether you want 
to select the theme

clicking More 
button displays 
additional 
gallery options 

mouse pointer on New 
Slide button arrow

image of 
slide helps to 
identify New 
Slide button

Enhanced 
ScreenTip for 
New Slide button
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Mini Toolbar and Shortcut Menus
The Mini toolbar, which appears automatically based on tasks you perform, contains 

commands related to changing the appearance of text in a slide. All commands on the 
Mini toolbar also exist on the Ribbon. The purpose of the Mini toolbar is to minimize 
mouse movement. For example, if you want to use a command that currently is not 
displayed on the active tab, you can use the command on the Mini toolbar - instead of 
switching to a different tab to use the command.

When the Mini toolbar appears, it initially is transparent (Figure 1–10a on 
the next page). If you do not use the transparent Mini toolbar, it disappears from the 
screen. To use the Mini toolbar, move the mouse pointer into the toolbar, which causes 
the Mini toolbar to change from a transparent to bright appearance (Figure 1–10b on 
the next page).

Figure 1–9

clicking Dialog Box 
Launcher in Clipboard 
group displays 
Clipboard task pane 

clicking Dialog Box 
Launcher in Font 
group displays Font 
dialog box

The lower-right corner of some groups on the Ribbon has a small arrow, called a 
Dialog Box Launcher, that when clicked displays a dialog box or a task pane with addi-
tional options for the group (Figure 1–9). When presented with a dialog box, you make 
selections and must close the dialog box before returning to the document. A task pane, 
by contrast, is a window that can remain open and visible while you work in the document.

Turning Off the Mini 
Toolbar
If you do not want the 
Mini toolbar to display, 
click the Offi ce Button, 
click the PowerPoint 
Options button on the 
Offi ce Button menu, and 
then clear the ‘Show Mini 
Toolbar on selection’ 
check box in the Popular 
panel.
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(a) Transparent Mini Toolbar (b) Bright Mini Toolbar

Figure 1–10

transparent 
Mini 
toolbar commands on 

Mini toolbar are 
also on Ribbon

bright Mini 
toolbar

A shortcut menu, which appears when you right-click an object, is a list of frequently 
used commands that relate to the right-clicked object. When you right-click a scroll bar, for 
example, a shortcut menu appears with commands related to the scroll bar. If you right-click 
an item in the document window, PowerPoint displays both the Mini toolbar and a shortcut 
menu (Figure 1–11).

Figure 1–11

Mini toolbar

right-clicked 
text

shortcut menu
some commands 
on Mini toolbar 
are also on 
shortcut menu

C6166_PPT_01.4c.indd   12C6166_PPT_01.4c.indd   12 3/7/07   9:57:56 AM3/7/07   9:57:56 AM



Quick Access Toolbar
The Quick Access Toolbar, located by default above the Ribbon, provides easy 

access to frequently used commands (Figure 1–12a). The commands on the Quick Access 
Toolbar always are available, regardless of the task you are performing. Initially, the Quick 
Access Toolbar contains the Save, Undo, and Redo commands. If you click the Customize 
Quick Access Toolbar button, PowerPoint provides a list of commands you quickly can 
add to and remove from the Quick Access Toolbar (Figure 1–12b).

Figure 1–12(a) Quick Access Toolbar above Ribbon

Undo button

Redo button
Quick Access 
Toolbar positioned 
above Ribbon

Save button

Figure 1–12(b) Customize Quick Access Toolbar

Customize 
Quick Access 
Toolbar button

Customize 
Quick Access 
Toolbar menu

commands you 
quickly can add to 
or delete from Quick 
Access Toolbar

Quick Access Toolbar 
Commands
To add a Ribbon 
command to the Quick 
Access Toolbar, right-
click the command on 
the Ribbon and then 
click Add to Quick Access 
Toolbar on the shortcut 
menu. To delete a 
command from the Quick 
Access Toolbar, right-click 
the command on the 
Quick Access Toolbar and 
then click Remove from 
Quick Access Toolbar on 
the shortcut menu. To 
display the Quick Access 
Toolbar below the Ribbon, 
right-click the Quick Access 
Toolbar and then click 
Place Quick Access Toolbar 
below the Ribbon on the 
shortcut menu.
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You also can add other commands to or delete commands from the Quick Access 
Toolbar so that it contains the commands you use most often. As you add commands to 
the Quick Access Toolbar, its commands may interfere with the document title on the 
title bar. For this reason, PowerPoint provides an option of displaying the Quick Access 
Toolbar below the Ribbon (Figure 1–12c).

Figure 1–12(c) Quick Access Toolbar below Ribbon

Each time you start PowerPoint, the Quick Access Toolbar appears the same way it 
did the last time you used PowerPoint. The chapters in this book, however, begin with the 
Quick Access Toolbar appearing as it did at the initial installation of the software. If you 
are stepping through this chapter on a computer and you want your Quick Access Toolbar 
to match the fi gures in this book, you should reset your Quick Access Toolbar. For more 
information about how to reset the Quick Access Toolbar, read Appendix E.

Offi ce Button  
While the Ribbon is a control center for creating documents, the Offi ce Button 

is a central location for managing and sharing documents. When you click the Offi ce 
Button, located in the upper-left corner of the window, PowerPoint displays the Offi ce 
Button menu (Figure 1–13). A menu contains a list of commands.

Quick Access Toolbar 
positioned below Ribbon

Figure 1–13

list of recently 
created Offi ce 
documents will 
appear here

Offi ce 
Button

Offi ce 
Button 
menu
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Figure 1–14

submenu

pointing to the arrow to 
the right of a command 
causes a submenu to be 
displayed

for the Prepare, Send, 
and Publish commands, 
pointing to the command 
or to the arrow causes a 
submenu to be displayed

Key Tips
If you prefer using the keyboard instead of the mouse, you can press the ALT key 

on the keyboard to display a Key Tip badge, or keyboard code icon, for certain commands 
(Figure 1–15). To select a command using the keyboard, press its displayed code letter, or 
Key Tip. When you press a Key Tip, additional Key Tips related to the selected command 
may appear. For example, to select the New command on the Offi ce Button menu, press 
the ALT key, then press the F key, then press the N key.

Figure 1–15

Key Tip badges 
appear when 
you press ALT 
key on keyboard

When you click the New, Open, Save As, and Print commands on the Offi ce Button 
menu, PowerPoint displays a dialog box with additional options. The Save As, Print, 
Prepare, Send, and Publish commands have an arrow to their right. If you point to this 
arrow, PowerPoint displays a submenu, which is a list of additional commands associated 
with the selected command (Figure 1–14). For the Prepare, Send, and Publish commands 
that do not display a dialog box when clicked, you can point either to the command or the 
arrow to display the submenu.
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Find the appropriate theme.
In the initial steps of this project, you will select a document theme by locating a particular 
built-in theme in the Themes group. You could, however, apply a theme at any time while 
creating the presentation. Some PowerPoint slide show designers create presentations using 
the default Offi ce Theme. This blank design allows them to concentrate on the words being 
used to convey the message and does not distract them with colors and various text attributes. 
Once the text is entered, the designers then select an appropriate document theme.

Plan 
Ahead

To remove the Key Tip badges from the screen, press the ALT key or the ESC key until 
all Key Tip badges disappear, or click the mouse anywhere in the PowerPoint window.

Choosing a Document Theme
You easily can give a presentation a professional and consistent appearance by using a 
document theme. This collection of formatting choices includes a set of colors (the color 
theme), a set of heading and content text fonts (the font theme), and a set of lines and fi ll 
effects (the effects theme). These themes allow you to choose and change the appearance 
of all the slides or individual slides in your presentation.

• Click Design on the 
Ribbon to display 
the Design tab 
(Figure 1–16).

1

To Choose a Document Theme

The document theme identifi er shows the theme currently used in the slide show. PowerPoint initially 
uses the Offi ce Theme until you select a different theme. The following steps change the theme for this 
presentation from the Offi ce Theme to the Flow document theme. 

Figure 1–16

groups on Ribbon change 
to show commands 
related to design because 
Design tab now is the 
active tab

themes in-
Ribbon gallery

Design tab
clicking More 
button in Themes 
gallery will show 
more design themes
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• Click the More button in the Themes 
gallery to expand the gallery, which 
shows more Built-In theme gallery 
options (Figure 1–17).

I Experiment

• Point to various document themes 
in the Themes gallery and watch 
the colors and fonts change on the 
title slide.

Are the themes displayed in a 
specifi c order?

Yes. They are arranged in 
alphabetical order running from 
left to right. If you point to a 
theme, a ScreenTip with the design’s 
name appears on the screen.

What if I change my mind and do 
not want to select a new theme? 

Click anywhere outside the All 
Themes gallery to close the gallery.

2

Q
&

A
Q

&
A

Figure 1–17

Offi ce Theme is 
default theme 
currently applied 

expanded 
gallery

Flow theme

Figure 1–18

• Click the Flow theme to apply this 
theme to Slide 1 (Figure 1–18).

If I decide at some future time that 
this design does not fi t the theme 
of my presentation, can I apply a 
different design? 

Yes. You can repeat these steps at 
any time while creating your 
presentation.

3

title text 
placeholder 
label

title text 
placeholder 
border

Flow theme 
applied to 
Slide 1

subtitle text 
placeholder 
border

Q
&

A
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Creating a Title Slide
With the exception of a blank slide and a slide with a picture and caption, PowerPoint 
assumes every new slide has a title. Many of PowerPoint’s layouts have both a title text 
placeholder and at least one content placeholder. To make creating a presentation easier, 
any text you type after a new slide appears becomes title text in the title text placeholder. 
The following steps create the title slide for this presentation.

Choose the words for the slide.
No doubt you have heard the phrase, “You get only one chance to make a fi rst impression.” 
The same philosophy holds true for a PowerPoint presentation. The title slide gives your 
audience an initial sense of what they are about to see and hear. It is, therefore, extremely 
important to choose the text for this slide carefully. Avoid stating the obvious in the title. 
Instead, create interest and curiosity using key ideas from the presentation.
Some PowerPoint users create the title slide as their last step in the design process so that it 
refl ects the tone of the presentation. They begin by planning the fi nal slide in the presenta-
tion so that they know where and how they want to end the slide show. All the slides in the 
presentation should work toward meeting this fi nal slide.

Plan 
Ahead

To Enter the Presentation Title

As you begin typing text in the title text placeholder, the title text also is displayed in the Slide 1 thumbnail in 
the Slides tab. PowerPoint line wraps text that exceeds the width of the placeholder. The presentation title for 
Project 1 is A World Beneath the Waves. This title creates interest by introducing the concept of exploring the life 
under water. The following step creates the slide show’s title.

• Click the label, Click to add title, 
located inside the title text place-
holder to select the placeholder 
(Figure 1–19).

1

Figure 1–19

sizing 
handles

I-beam 
mouse 
pointer

label disappears 
when placeholder 
is selected

dashed lines around 
border indicate 
placeholder is selected
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Figure 1–20

• Type A World Beneath the 
Waves in the title text placeholder. 
Do not press the ENTER key 
(Figure 1–20).

What if a button with two lines and 
two arrows appears on the left side 
of the title text placeholder?

The AutoFit button displays because 
PowerPoint attempts to reduce the 
size of the letters when the title text 
does not fi t on a single line. If you are 
creating a slide and need to squeeze 
an extra line in the text placeholder, 
you can click this button to resize the 
existing text in the placeholder so the 
spillover text will fi t on the slide.

2

title text entered 
in placeholder

subtitle text 
placeholder label

Correcting a Mistake When Typing
If you type the wrong letter, press the BACKSPACE key to erase all the characters back 

to and including the one that is incorrect. If you mistakenly press the ENTER key after typ-
ing the title and the insertion point is on the new line, simply press the BACKSPACE key to 
return the insertion point to the right of the letter s in the word Waves.

When you install PowerPoint, the default setting allows you to reverse up to the 
last 20 changes by clicking the Undo button on the Quick Access Toolbar. The ScreenTip 
that appears when you point to the Undo button changes to indicate the type of change 
just made. For example, if you type text in the title text placeholder and then point to the 
Undo button, the ScreenTip that appears is Undo Typing. For clarity, when referencing 
the Undo button in this project, the name displaying in the ScreenTip is referenced. You 
can reapply a change that you reversed with the Undo button by clicking the Redo button 
on the Quick Access Toolbar. Clicking the Redo button reverses the last undo action. The 
ScreenTip name refl ects the type of reversal last performed.

Paragraphs
Subtitle text in the subtitle text placeholder supports the title text. It can appear on 

one or more lines in the placeholder. To create more than one subtitle line, you press the 
ENTER key after typing some words. PowerPoint creates a new line, which is the second 
paragraph in the placeholder. A paragraph is a segment of text with the same format that 
begins when you press the ENTER key and ends when you press the ENTER key again. This 
new paragraph is the same level as the previous paragraph. A level is a position within a 
structure, such as an outline, that indicates the magnitude of importance. PowerPoint allows 
for fi ve paragraph levels.

Creating a Title Slide   PPT 19
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To Enter the Presentation Subtitle Paragraph

The fi rst subtitle paragraph links to the title by giving specifi c details about the vacation location, and the 
second paragraph gives information about the person who will be speaking to the audience. The following steps 
enter the presentation subtitle.

• Click the label, Click to add subtitle, 
located inside the subtitle text place-
holder to select the placeholder 
(Figure 1–21).

1

Figure 1–21

dashed lines around 
border indicate 
placeholder is selected

label disappears 
when placeholder 
is selected

• Type Spring Break in Cabo San 
Lucas, Mexico and then press the 
ENTER key.

• Type Presented by Dave Ehlin, 
SGA President but do not press 
the ENTER key (Figure 1–22).

Why do red wavy lines appear below 
the words, Cabo and Ehlin?

The lines indicate possible spelling 
errors.

2

Figure 1–22

subtitle text 
entered in 
placeholder

red wavy lines 
indicate possible 
misspelled words

Q
&

A

Identify how to format specifi c elements of the text.
Most of the time, you use the document theme’s text attributes, color scheme, and layout. 
Occasionally, you may want to change the way a presentation looks, however, and still keep 
a particular document theme. PowerPoint gives you that fl exibility.

Graphic designers use several rules when formatting text.

• Avoid all capital letters, if possible. Audiences have diffi culty comprehending sentences 
typed in all capital letters, especially when the lines exceed seven words. All capital letters 
leaves no room for emphasis or infl ection, so readers get confused about what material 
deserves particular attention. Some document themes, however, have a default title text 
style of all capital letters.

• Avoid text with a font size less than 24 point. Audience members generally will sit a 
maximum of 50 feet from a screen, and at this distance 24-point type is the smallest size 
text they can read comfortably without straining.

• Make careful color choices. Color evokes emotions, and a careless color choice may elicit 
the incorrect psychological response. PowerPoint provides a color palette with hundreds of 
colors. The built-in document themes use complementary colors that work well together. 
If you stray from these themes and add your own color choices, without a good reason to 
make the changes, your presentation is apt to become ineffective. 

Plan 
Ahead
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Formatting Characters in a Presentation
Recall that each document theme determines the color scheme, font and font size, and 
layout of a presentation. You can use a specifi c document theme and then change the 
characters’ formats any time before, during, or after you type the text.

Fonts and Font Styles
Characters that appear on the screen are a specifi c shape and size. Examples of 

how you can modify the appearance, or format, of these typed characters on the screen 
and in print include changing the font, style, size, and color. The font, or typeface, 
defi nes the appearance and shape of the letters, numbers, punctuation marks, and symbols. 
Style indicates how the characters are formatted. PowerPoint’s text font styles include 
regular, italic, bold, and bold italic. Size specifi es the height of the characters and is 
gauged by a measurement system that uses points. A point is 1/72 of an inch in height. 
Thus, a character with a point size of 36 is 36/72 (or 1/2) of an inch in height. Color 
defi nes the hue of the characters.

This presentation uses the Flow document theme, which uses particular font styles 
and font sizes. The Flow document theme default title text font is named Calibri. It has 
a bold style with no special effects, and its size is 56 point. The Flow document theme 
default subtitle text font is Constantia with a font size of 26 point.

Formatting Words 
To format one word, 
position the insertion 
point anywhere in the 
word. Then make the 
formatting changes you 
desire. The entire word 
does not need to be 
selected for the change 
to occur.

B
T
W
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To Select a Paragraph

You can use many techniques to format characters. When you want to apply the same formats to multiple 
words or paragraphs, it is effi cient to select the desired text and then make the desired changes to all the characters 
simultaneously. The fi rst formatting change you will make will apply to the second paragraph of the title slide sub-
title. The following step selects this paragraph.

• Triple-click the paragraph, Presented 
by Dave Ehlin, SGA President, in the 
subtitle text placeholder to select 
the paragraph (Figure 1–23).

Can I select the paragraph using a 
technique other than triple-clicking? 

Yes. You can move your mouse 
pointer to the left of the fi rst 
paragraph and then drag it to the 
end of the line. 

1

Figure 1–23

subtitle text 
paragraph to 
be formatted 
is selected

transparent Mini 
toolbar appears 
whenever you 
select text
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To Italicize Text

Different font styles often are used on slides to make them more appealing to the reader and to emphasize 
particular text. Italic type, used sparingly, draws the readers’ eyes to these characters. The following step adds 
emphasis to the second line of the subtitle text by changing regular text to italic text.

• With the subtitle text still selected, 
click the Italic button on the Mini tool-
bar to italicize that text on the slide 
and on the slide thumbnail 
(Figure 1–24).

If I change my mind and decide 
not to italicize the text, how can I 
remove this style?

Select the italicized text and then click 
the Italic button. As a result, the Italic 
button will not be selected, and the 
text will not have the italic font style. 

Figure 1–24

selected paragraph 
has italic font style 
applied

Italic button 
selected

1. Right-click selected text, 
click Font on shortcut 
menu, click Italic in Font 
style list

2. Click Home tab, click Italic 
in Font group

3. Press CTRL+I

Other Ways

1

Q
&

A

To Select Multiple Paragraphs

Each of the subtitle lines is a separate paragraph. As previously discussed, PowerPoint creates a new paragraph 
each time you press the ENTER key. To change the character formatting in both paragraphs, it is effi cient to select the 
desired text and then make the desired changes to all the characters simultaneously.

The next formatting change you will make will apply to both title slide subtitle paragraphs. The following step 
selects the fi rst paragraph so that you can format both paragraphs concurrently.

Figure 1–25

• With the second subtitle text 
paragraph selected, press the CTRL key 
and then triple-click the fi rst subtitle 
text paragraph, Spring Break in Cabo 
San Lucas, Mexico, to select both 
paragraphs (Figure 1–25).

Can I use a different technique to 
select both subtitle text paragraphs? 

Yes. Click the placeholder border so 
that it appears as a solid line. When 
the placeholder is selected in this 
manner, formatting changes will 
apply to all text in the placeholder.

1

solid line indicates 
both subtitle 
text paragraphs 
selected

transparent Mini toolbar 
appears when second 
paragraph is selected

Q
&

A
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To Change the Text Color

PowerPoint allows you to use one or more text colors in a presentation. To add more emphasis to the title slide 
subtitle text, you decide to change the color. The following steps add emphasis to both subtitle text paragraphs by 
changing the font color from white to dark blue.

1

2

3

Figure 1–26

• With both paragraphs selected, click 
the Font Color arrow on the Mini 
toolbar to display the palette of 
Theme Colors and Standard Colors 
(Figure 1–26).

If the Mini toolbar disappears from 
the screen, how can I display it 
once again? 

Right-click the text, and the Mini 
toolbar should appear. 

Figure 1–27

• Click the Dark Blue button in the 
Standard Colors row on the 
Mini toolbar (row 1, column 9) to 
change the font color to dark blue 
(Figure 1–27).

Why did I select the color, dark blue?

Dark blue is one of the 10 standard 
colors associated with every docu-
ment theme, and it works well with 
the shades of blue already on the 
slide. An additional consideration is 
that dark colors print well.

• Click outside the selected area 
to deselect the two paragraphs.

Dark Blue 
button

Standard Colors 
row has colors 
associated with 
every theme

orange border 
indicates current 
font color

color 
palette

Theme Colors 
row shows Flow 
theme colorsFont Color arrow

Font Color button 
indicates current 
text color

subtitle text 
paragraphs 
color changed 
to dark blue

Q
&

A

Other Ways

1. Right-click selected text, 
click Font on shortcut 
menu, click Font color 
button, click Dark Blue 
in Standard Colors row

2. Click Home tab, click 
Font Color arrow in Font 
group, click Dark Blue in 
Standard Colors row

Identify how to format specifi c elements of the text.
When selecting text colors, try to limit using red. At least 15 percent of men have diffi culty 
distinguishing varying shades of green or red. They also often see the color purple as blue 
and the color brown as green. This problem is more pronounced when the colors appear in 
small areas, such as slide paragraphs or line chart bars.

Plan 
Ahead
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To Select a Group of Words

PowerPoint designers use many techniques to format characters. To apply the same formats to multiple words 
or paragraphs, they select the desired text and then make the desired changes to all the characters simultaneously.

To add emphasis to the vacation destination, you want to increase the font size and change the font style to 
bold for the words, Cabo San Lucas. You could perform these actions separately, but it is more effi cient to select this 
group of words and then change the font attributes. The following steps select a group of words.

• Position the mouse pointer 
immediately to the left of the fi rst 
character of the text to be selected 
(in this case, the C in Cabo) 
(Figure 1–28).

1

• Drag the mouse pointer through 
the last character of the text to be 
selected (in this case, the s in Lucas) 
(Figure 1–29).

2

Figure 1–28

mouse pointer 
(I-beam) at 
beginning of 
text to select

Figure 1–29

mouse
pointer

words, Cabo San 
Lucas, selected

To Increase Font Size

To add emphasis, you increase the font size for Cabo San Lucas. The Increase Font Size button on the Mini 
toolbar increases the font size in preset increments. The following step uses this button to increase the font size.

• Click the Increase Font Size button 
on the Mini toolbar once to increase 
the font size of the selected text 
from 26 to 28 point (Figure 1–30).

1

Figure 1–30

font size of 
selected words 
increased

Bold button

Increase Font Size 
button selected

Other Ways

1. Click Home tab, click 
Increase Font Size 
button in Font group 

2. Click Home tab, click 
Font Size box  arrow, 
click new font size

3. Press CTRL+SHIFT+>

C6166_PPT_01.4c.indd   24C6166_PPT_01.4c.indd   24 3/7/07   9:58:20 AM3/7/07   9:58:20 AM



To Bold Text

Bold characters display somewhat thicker and darker than those that display in a regular font style. Clicking 
the Bold button on the Mini toolbar is an effi cient method of bolding text. To add more emphasis to the vacation 
destination, you want to bold the words, Cabo San Lucas. The following step bolds this text.

• Click the Bold button on the Mini 
toolbar to bold the three selected 
words (Figure 1–31).

1

Figure 1–31

selected words 
are bold

Bold button 
selected

Other Ways

1. Click Home tab, click 
Bold button in Font 
group

2. Press CTRL+B

To Decrease the Title Slide Title Text Font Size

The last word of the title text, Waves, appears on a line by itself. For aesthetic reasons, it is advantageous to 
have this word appear with the rest of the title on a single line. One way to fi t text on one line is to decrease the font 
size. The process is similar to increasing the font size. Clicking the Decrease Font Size button on the Mini toolbar 
decreases the size in preset increments. The following steps decrease the font size from 56 to 48 point.

Identify how to format specifi c elements of the text.
Avoid line wraps. Your audience’s eyes want to stop at the end of a line. Thus, you must plan 
your words carefully or adjust the font size so that each point displays on only one line.

Plan 
Ahead

• Select the title slide title text, A 
World Beneath the Waves 
(Figure 1–32).

1

Figure 1–32

title text 
selected

Decrease Font 
Size button

current
default font 
size is 56 point
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• Click the Decrease Font Size 
button on the Mini toolbar twice to 
decrease the font size from 56 to 
48 point (Figure 1–33).

2

Figure 1–33

Decrease Font 
Size button 
selected

font size is 
now 48 point

font size of selected 
text decreased, so 
words appear on 
one line

Other Ways

1. Click Home tab, click 
Decrease Font Size 
button in Font group

2. Click Home tab, click 
Font Size box arrow, 
click new font size

3. Press CTRL+SHIFT+<

Saving the Project
While you are building a presentation, the computer stores it in memory. When you 
save a presentation, the computer places it on a storage medium such as a USB fl ash drive, 
CD, or hard disk. A saved presentation is referred to as a fi le. A fi le name is the name 
assigned to a fi le when it is saved.

It is important to save the presentation frequently for the following reasons:

• The presentation in memory will be lost if the computer is turned off or you lose 
electrical power while PowerPoint is open.

• If you run out of time before completing your project, you may fi nish your presentation 
at a future time without starting over.

Determine where to save the document.
When saving a document, you must decide which storage medium to use.

• If you always work on the same computer and have no need to transport your projects to 
a different location, then your computer’s hard drive will suffi ce as a storage location. It 
is a good idea, however, to save a backup copy of your projects on a separate medium in 
case the fi le becomes corrupted or the computer’s hard drive fails.

• If you plan to work on your projects in various locations or on multiple computers, then 
you should save your projects on a portable medium, such as a USB fl ash drive or CD. The 
projects in this book use a USB fl ash drive, which saves fi les quickly and reliably and can 
be reused. CDs are easily portable and serve as good backups for the fi nal versions of 
projects because they generally can save fi les only one time.

Plan 
Ahead

Saving in a Previous 
PowerPoint Format
To ensure that your 
presentation will open 
in an earlier version 
of PowerPoint, you 
must save your fi le in 
PowerPoint 97–2003 
format. Files saved in 
this format have the .ppt 
extension.

B
T
W
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To Save a Presentation

You have performed many tasks and do not want to lose the work completed thus far. Thus, you should save the 
presentation. The following steps save a presentation on a USB fl ash drive using the fi le name, Cabo Package.

Figure 1–34

Save As 
dialog box

• With a USB fl ash drive connected 
to one of the computer’s USB ports, 
click the Save button on the Quick 
Access Toolbar to display the Save As 
dialog box. (Figure 1–34).

Do I have to save to a USB fl ash drive?

No. You can save to any device or 
folder. A folder is a specifi c location 
on a storage medium. You can save to 
the default folder or a different folder. 
You also can create your own folders, 
which is explained later in this book.

1
Save 
button

My Documents is default 
folder (your default 
folder may differ)

words in title text 
placeholder on title 
slide are displayed 
as default fi le name 
and are selected in 
File name text box

default fi le type 
is PowerPoint 
Presentation

Figure 1–35

• Type Cabo Package in the File 
name box to change the fi le name. 
Do not press the ENTER key after 
typing the fi le name (Figure 1–35).

What characters can I use in a 
fi le name? 

A fi le name can have a maximum 
of 255 characters, including spaces. 
The only invalid characters are the 
backslash (\), slash (/), colon (:), 
asterisk (*), question mark (?), 
quotation mark (“), less than symbol 
(<), greater than symbol (>), and 
vertical bar (|). 

2

Q
&

A

selected words in default 
fi le name automatically 
are replaced when you 
type the new fi le name clicking Cancel 

button will 
close the Save 
As dialog box

Saving the Project   PPT 27

Po
w

er
Po

in
t 

C
h

ap
te

r 
1

Q
&

A

Po
w

er
Po

in
t 

C
h

ap
te

r 
1

C6166_PPT_01.4c.indd   27C6166_PPT_01.4c.indd   27 3/7/07   9:58:26 AM3/7/07   9:58:26 AM



PPT 28   PowerPoint Chapter 1   Creating and Editing a Presentation

• Click the Save in box arrow to 
display a list of available drives and 
folders (Figure 1–36).

Why is my list of fi les, folders, and 
drives arranged and named dif-
ferently from those shown in the 
fi gure?

Your computer’s confi guration 
determines how the list of fi les and 
folders is displayed and how drives 
are named. You can change the save 
location by clicking shortcuts on the 
My Places bar. 

How do I save the fi le if I am not 
using a USB fl ash drive? 

Use the same process, but be certain 
to select your device in the Save 
in list. 

3

Figure 1–36

project to be 
saved on USB 
fl ash drive

My Places bar 
allows you to 
change save 
location

list of available 
drives and folders is 
displayed in Save in list

Save in 
box arrow

• Click UDISK 2.0 (E:) in the Save in list 
to select the USB fl ash drive, Drive E 
in this case, as the new save location 
(Figure 1–37).

What if my USB fl ash drive has a 
different name or letter?

It is very likely that your USB fl ash 
drive will have a different name and 
drive letter and be connected to a 
different port. Verify the device in 
your Save in list is correct.

4

Figure 1–37

USB fl ash 
drive is new 
save location

no PowerPoint fi les 
currently saved on USB 
fl ash drive, so no fi le 
names are displayed

Save 
button

Q
&

A
Q

&
A

Q
&

A
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• Click the Save button in the Save As 
dialog box to save the presentation 
on the USB fl ash drive with the fi le 
name, Cabo Package (Figure 1–38).

How do I know that the project is 
saved?

While PowerPoint is saving your 
fi le, it briefl y displays a message 
on the status bar indicating the 
amount of the fi le saved. In addi-
tion, your USB drive may have a 
light that fl ashes during the save 
process.

5

Figure 1–38

Q
&

A project name changed 
from Presentation1 to new 
fi le name, Cabo Package

saved document 
remains in memory 
and is displayed on 
the screen

Adding a New Slide to a Presentation
With the title slide for the presentation created, the next step is to add the fi rst text slide 
immediately after the title slide. Usually, when you create a presentation, you add slides with 
text, graphics, or charts. Some placeholders allow you to double-click the placeholder and 
then access other objects, such as media clips, charts, diagrams, and organization charts. You 
can change the layout for a slide at any time during the creation of a presentation.

To Add a New Text Slide with a Bulleted List

When you add a new slide, PowerPoint uses the Title and Content slide layout. This layout provides a 
title placeholder and a content area for text, art, charts, and other graphics. A vertical scroll bar appears in 
the Slide pane when you add the second slide so that you can move from slide to slide easily. A thumbnail 
of this slide also appears in the Slides tab. The following steps add a new slide with the Title and Content 
slide layout.
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Figure 1–39

• Click Home on the Ribbon to display 
the Home tab (Figure 1–39).

1 Home tab 

• Click the New Slide 
button in the Slides 
group to insert a new 
slide with the Title 
and Content layout 
(Figure 1–40).

Why does the bullet 
character display a 
blue dot?

The Flow document 
theme determines the 
bullet characters. Each 
paragraph level has 
an associated bullet 
character. 

I clicked the New 
Slide arrow instead 
of the New Slide but-
ton. What should I do?

Click the Title and 
Content slide thumb-
nail in the layout 
gallery.

2

title text 
placeholder 
label

Figure 1–40

Q
&

A
Q

&
A

New Slide 
button

orange border 
indicates current 
slide is displayed

Slide 2 added 
to presentation

default 
bullet 
character

Title and Content 
layout has two 
placeholders

vertical scroll bar 
appears when second 
slide is added to 
presentation

scroll
box

scroll arrow

Previous 
Slide button

Next Slide button

Other Ways

1. Press CTRL+M
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Creating a Text Slide with a Single-Level 
Bulleted List
The information in the Slide 2 text placeholder is presented in a bulleted list. All the bullets 
appear at the same paragraph level, called the fi rst level.

To Enter a Slide Title

PowerPoint assumes every new slide has a title. The title for Slide 2 is Package Highlights. The following step 
enters this title.

• Click the label, Click to add title, 
to select it and then type Package 
Highlights in the placeholder. Do 
not press the ENTER key (Figure 1–41).

What are those six icons grouped in 
the middle of the slide? 

You can click one of the icons to 
insert a specifi c type of content: 
table, chart, SmartArt graphic, 
picture, clip art, or media clip.

1

Figure 1–41

Slide 2 title text appears 
in title text placeholder 
and Slide 2 thumbnail

bulleted 
paragraph label in 
text placeholder

icon 
group 

To Select a Text Placeholder

Before you can type text into the text placeholder, you fi rst must select it. The following step selects the text 
placeholder on Slide 2. 1

• Click the label, Click to add text, 
to select the text placeholder 
(Figure 1–42).

Why does my mouse pointer have a 
different shape?

If you move the mouse pointer away 
from the bullet, it will change shape. 

1

Figure 1–42

bulleted 
paragraph label 
disappears when 
placeholder is 
selected

I-beam mouse 
pointer

dashed-line border 
indicates placeholder 
is selected

Other Ways

1. Press CTRL+ENTER 
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Choose the words for the slide.
All presentations should follow the 7 � 7 rule which states that each slide should have a 
maximum of seven lines, and each line should have a maximum of seven words. PowerPoint 
designers must choose their words carefully and, in turn, help viewers read the slides easily.
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To Type a Single-Level Bulleted List

The content placeholder provides an area for the text characters. When you click inside a placeholder, you 
then can type or paste text. If your text exceeds the size of the placeholder, PowerPoint will attempt to make the text 
fi t by reducing the text size and line spacing. Line spacing is the amount of vertical space between the lines of text.

As discussed previously, a bulleted list is a list of paragraphs, each of which is preceded by a bullet. A 
paragraph is a segment of text ended by pressing the ENTER key. The next step is to type the single-level bulleted 
list, which consists of fi ve paragraphs (Figure 1–1b on page PPT 3). The following steps create a single-level 
bulleted list.

• Type Four nights at the Azure 
Seas Resort and then press the 
ENTER key to begin a new bulleted 
fi rst-level paragraph (Figure 1–43).

Can I delete bullets on a slide?

Yes. If you do not want bullets to 
display on a particular paragraph, 
click the Bullets button in the 
Paragraph group on the Home tab 
or right-click the paragraph and 
then click the Bullets button on the 
Mini toolbar.

1

Q
&

A

Figure 1–43

Figure 1–44

• Type Breakfast buffet, lunch, 
dinner, and snacks and then 
press the ENTER key.

• Type Two large swimming pools 
and then press the ENTER key.

• Type Round-trip airfare and 
hotel transfers and then press 
the ENTER key.

• Type Daily activities, 
including water sports 
but do not press the ENTER key 
(Figure 1–44).

I pressed the ENTER key in error, and 
now a new bullet appears after the 
last entry on this slide. How can I 
remove this extra bullet? 

Press the BACKSPACE key.

2

Q
&

A

Bullets 
button 
selected

fi rst-level 
paragraph

fi rst-level 
paragraph 
text entered
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Creating a Text Slide with a Multi-Level 
Bulleted List  
Slides 3 and 4 in Figure 1–1 on pages PPT 3 and 4 contain more than one level of 
bulleted text. A slide that consists of more than one level of bulleted text is called a 
multi-level bulleted list slide. Beginning with the second level, each paragraph indents 
to the right of the preceding level and is pushed down to a lower level. For example, if you 
increase the indent of a fi rst-level paragraph, it becomes a second-level paragraph.

Creating a text slide with a multi-level bulleted list requires several steps. Initially, 
you enter a slide title in the title text placeholder. Next, you select the content text place-
holder. Then, you type the text for the multi-level bulleted list, increasing and decreasing 
the indents as needed. The next several sections add a slide with a multi-level bulleted list.

To Add a New Slide and Enter a Slide Title

When you add a new slide to a presentation, PowerPoint keeps the same layout used on the previous slide. 
PowerPoint assumes every new slide has a title. The title for Slide 3 is Rates and Booking. The following steps add a 
new slide (Slide 3) and enter a title.

• Click the New Slide 
button in the Slides 
group on the Home 
tab to insert a new 
slide with the Title 
and Content layout 
(Figure 1–45).

1

Figure 1–45

New Slide 
button

orange border 
indicates current 
slide is displayed

title text 
placeholder

Slide 3 added 
to presentation
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To Type a Multi-Level Bulleted List

In a multi-level bulleted list, a lower-level paragraph is a subset of a higher-level paragraph. It usually contains 
information that supports the topic in the paragraph immediately above it.

The next step is to select the content text placeholder and then type the multi-level bulleted list, which consists of 
six entries (Figure 1–1c on page PPT 3). Creating a lower-level paragraph is called demoting text; creating a higher-level 
paragraph is called promoting text. The following steps create a list consisting of three levels.

• Click the title text placeholder and 
then type Rates and Booking in 
this placeholder. Do not press the 
ENTER key (Figure 1–46).

2

Figure 1–46

• Click the bulleted paragraph text 
placeholder.

• Type Only $495 double 
occupancy and then press the 
ENTER key (Figure 1–47).

1

Figure 1–47

bulleted paragraph 
label in text 
placeholder

title entered 
in title text 
placeholder

fi rst-level 
paragraph

1. Press SHIFT+CTRL+M

Other Ways
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• Click the Increase List Level button 
in the Paragraph group to indent 
the second paragraph below the 
fi rst and create a second-level 
paragraph (Figure 1–48).

Why does the bullet for this 
paragraph have a different size 
and color? 

A different bullet is assigned to each 
paragraph level.

2

Figure 1–48

• Type Non-diver rate: $275 and 
then press the ENTER key to add a 
new paragraph at the same level as 
the previous paragraph.

• Type Single occupancy: add 
$150 and then press the ENTER key 
(Figure 1–49).

3

Figure 1–49

• Click the Decrease List 
Level button in the 
Paragraph group so 
that the second-level 
paragraph becomes a 
fi rst-level paragraph 
(Figure 1–50).

4

Figure 1–50

Increase List 
Level button

second-level 
paragraph 
bullet indented 

paragraph

second-level 
bullet

second-level 
paragraph
text entered

Decrease List Level 
button not selected 
because paragraph level 
cannot be decreased

fi rst-level 
bullets

1. Press TAB to promote 
paragraph; press 
SHIFT+TAB to demote 
paragraph

Other Ways

Q
&

A
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To Type the Remaining Text for Slide 3

The following steps complete the text for Slide 3.

Type Nonrefundable $150 deposit required and then press the ENTER key.

Click the Increase List Level button in the Paragraph group to demote the paragraph.

Type Due by October 1 and then press the ENTER key.

Click the Decrease List Level button in the Paragraph group to promote the paragraph.

Type Travel insurance highly recommended but do not press the ENTER key 
(Figure 1–51).

1

2

3

4

5

Figure 1–51

multi-level 
bulleted list 
text added 
to slide
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To Create Slide 4

Slide 4 is the fi nal multi-level bulleted text slide in this presentation. It has three 
levels. The following steps create Slide 4.

Click the New Slide button in the Slides group.

Type Snorkeling and Diving in the title text placeholder.

Press CTRL+ENTER to move the insertion point to the text placeholder.

Type Three days of two-tank boat dives and then press the ENTER key.

Click the Increase List Level button. Type Weights and tanks included and then press 
the ENTER key (Figure 1–52). 

1

2

3

4

5

To Create a Third-Level Paragraph

Slide 4 contains detailed information about the particular dives. Each additional paragraph becomes more 
specifi c and supports the information in the paragraph above it.

The next line in Slide 4 is indented an additional level, to the third level. The following steps demote the text to a 
third-level paragraph.

Figure 1–52

second-level 
paragraph bullet

Slide 4 added to 
presentation

text added to 
title and text 
placeholders
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• Click the Increase List Level button 
so that the second-level paragraph 
becomes a third-level paragraph 
(Figure 1–53).

1

Figure 1–53

• Type Instructors available 
for beginners and then press the 
ENTER key to create a second third-
level paragraph (Figure 1–54).

2

Figure 1–54

Figure 1–55

• Click the Decrease List Level button 
two times so that the insertion point 
appears at the fi rst level (Figure 1–55).

3

Increase List 
Level button

third-level 
paragraph bullet

third-level 
paragraphs

fi rst-level 
paragraph 
bullets

Decrease List 
Level button
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To Type the Remaining Text for Slide 4

The next three paragraphs concern what divers and snorkelers will view. The following 
steps type the remaining text for Slide 4.

Type Various locations based on diving skills and then press the ENTER key.

Press the TAB key to increase the indent to the second level.

Type Spectacular underwater wildlife and landscapes and then press the ENTER key.

Press the TAB key to increase the indent to the third level.

Type See squids, sea turtles, snakes, barracudas, and stingrays but do 
not press the ENTER key (Figure 1–56).

1

2

3

4

Figure 1–56

Choose the words for the slide.
After the last bulleted list slide in the slide show appears during a slide show, the default 
PowerPoint setting is to end the presentation with a black slide. This black slide appears 
only when the slide show is running and concludes the slide show, so your audience never 
sees the PowerPoint window. It is a good idea, however, to end the presentation with a 
fi nal, closing slide to display at the end of the presentation. This slide ends the presen-
tation gracefully and should be an exact copy, or a very similar copy, of your title slide. 
The audience will recognize that the presentation is drawing to a close when this slide 
appears. It can remain on the screen when the audience asks questions, approaches the 
speaker for further information, or exits the room.     

Plan 
Ahead

5

multi-level 
bulleted list 
text added 
to slide
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Ending a Slide Show with a Closing Slide
All the text slides are created for the Cabo Package slide show. This presentation thus far 
consists of a title slide, one text slide with a single-level bulleted list, and two text slides 
with a multi-level bulleted list. A closing slide that resembles the title slide is the fi nal slide 
to create.

To Duplicate a Slide

When two slides contain similar information and have the same format, duplicating one slide and then making 
minor modifi cations to the new slide saves time and increases consistency.

Slide 5 will have the same layout and design as Slide 1. The most expedient method of creating this slide is to 
copy Slide 1 and then make minor modifi cations to the new slide. The following steps duplicate the title slide.

• Click the Slide 1 thumbnail in the 
Slides tab to display Slide 1 
(Figure 1–57).

1

Figure 1–57

• Click the New Slide arrow in the 
Slides group on the Home tab to 
display the Flow layout gallery 
(Figure 1–58).

2

Figure 1–58

Slide 1 is 
displayed

Slide 1 
thumbnail  
is selected

Slides tab

Flow layout 
gallery

New Slide 
arrow

clicking Duplicate 
Selected Slides 
creates copy of 
selected Slide 1
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To Arrange a Slide

The new Slide 2 was inserted directly below Slide 1 because Slide 1 was the selected slide. This duplicate slide 
needs to display at the end of the presentation directly after the fi nal title and content slide.

Changing slide order is an easy process and is best performed in the Tabs pane. When you click the slide 
thumbnail and begin to drag it to a new location, a line indicates the new location of the selected slide. When you 
release the mouse button, the slide drops into the desired location. Hence, this process of dragging and then drop-
ping the thumbnail in a new location is called drag and drop. You can use the drag-and-drop method to move any 
selected item, including text and graphics. The following step moves the new Slide 2 to the end of the presentation 
so that it becomes a closing slide.

• Click Duplicate Selected Slides in 
the Flow layout gallery to create 
a new Slide 2, which is a duplicate 
of Slide 1 (Figure 1–59).

3

Figure 1–59

Slide 2 is 
selected and 
is duplicate 
of Slide 1

presentation 
consists of 
fi ve slides
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To Delete All Text in a Placeholder

To keep the ending slide clean and simple, you want only the slide show title, A World Beneath the Waves, to 
display on Slide 5. The following steps delete both paragraphs in the subtitle placeholder.

• With Slide 2 selected, drag the Slide 2 
slide thumbnail in the Slides pane 
below the last slide thumbnail 
(Figure 1–60).

1

Figure 1–60

• With Slide 5 selected, click the 
subtitle text placeholder to select it 
(Figure 1–61).

1

Figure 1–61

duplicate slide 
in new location 
at end of 
presentation

dashed line 
indicates subtitle 
text placeholder 
selected

Slide 5 is 
selected

Other Ways

1. Click slide icon on 
Outline tab, drag icon 
to new location

2. In Slide Sorter view 
click slide thumbnail, 
drag thumbnail to new 
location
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Changing Document Properties and Saving Again
PowerPoint helps you organize and identify your fi les by using document properties, 
which are the details about a fi le. Document properties, also known as metadata, can 
include such information as the project author, title, or subject. Keywords are words or 
phrases that further describe the document. For example, a class name or document topic 
can describe the fi le’s purpose or content.

Document properties are valuable for a variety of reasons:

• Users can save time locating a particular fi le because they can view a document’s 
properties without opening the document.

• By creating consistent properties for fi les having similar content, users can better 
organize their documents.

• Some organizations require PowerPoint users to add document properties so that 
other employees can view details about these fi les.
Five different types of document properties exist, but the more common ones used 

in this book are standard and automatically updated properties. Standard properties 

• Click the subtitle text placeholder 
border to change the border from 
a dashed line to a solid line 
(Figure 1–62).

2

Figure 1–62

• Click the Cut button in the Clipboard 
group on the Home tab to delete 
all the text in the subtitle text 
placeholder (Figure 1–63).

3

Figure 1–63

clicking placeholder 
border changes 
border to solid line

Cut button

subtitle 
paragraphs are 
deleted from 
placeholder

Other Ways

1. Right-click selected text, 
click Cut on shortcut 
menu

2. Select text, press 
DELETE key

3. Select text, press CTRL+X

Converters for Earlier 
PowerPoint Versions
The Microsoft Web 
site has updates and 
converters if you are 
using earlier versions 
of PowerPoint. The 
Microsoft Offi ce 
Compatibility Pack 
for Word, Excel and 
PowerPoint 2007 File 
Format will allow you 
to open, edit, and save 
Offi ce 2007 documents 
that you receive without 
saving them in the earlier 
version’s fi le format.

B
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are associated with all Microsoft Offi ce documents and include author, title, and subject. 
Automatically updated properties include fi le system properties, such as the date you 
create or change a fi le, and statistics, such as the fi le size.

To Change Document Properties

The Document Information Panel contains areas where you can view and enter document properties. You 
can view and change information in this panel at any time while you are creating a document. Before saving the 
presentation again, you want to add your name and class name as document properties. The following steps use the 
Document Information Panel to change document properties.

• Click the Offi ce Button to display 
the Offi ce Button menu.

• Point to Prepare on the Offi ce 
Button menu to display the 
Prepare submenu (Figure 1–64).

What other types of actions besides 
changing properties can you take to 
set up a document for 
distribution?

The Prepare submenu 
provides commands 
related to sharing a document 
with others, such as allowing or 
restricting people to view and modify 
your document, checking to see if 
your presentation will run in earlier 
versions of PowerPoint, and searching 
for hidden personal information.

1

Figure 1–64

Q
&

A

• Click Properties on the Prepare 
submenu to display the Document 
Information Panel (Figure 1–65).

Why are some of the document 
properties in my Document 
Information Panel already fi lled in?

The person who installed Microsoft 
Offi ce 2007 on your computer 
or network may have set or 
customized the properties.

2

Figure 1–65

Q
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A

Offi ce 
Button

clicking Properties 
command will open 
the Document 
Information Panel

Offi ce 
Button 
menu

Prepare submenu 
displays a list of tasks 
that can be used to set 
up fi les for distribution

Document 
Information Panel 
is displayed at top 
of document

student name 
will be typed in 
Author text box

course number and 
section will be typed 
in Subject text box
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To Save an Existing Presentation with the Same File Name

Saving frequently cannot be overemphasized. You have made several modifi cations to the presentation since 
you saved it earlier in the chapter. When you fi rst saved the document, you clicked the Save button on the Quick 
Access Toolbar, the Save As dialog box appeared, and you entered the fi le name, Cabo Package. If you want to use 
the same fi le name to save the changes made to the document, you again click the Save button on the Quick Access 
Toolbar. The following step saves the presentation again.

Figure 1–66

• Click the Author text 
box, if necessary, 
and then type your 
name as the Author 
property. If a name 
already is displayed in 
the Author text box, 
delete it before typing 
your name.

• Click the Subject text 
box, if necessary delete 
any existing text, and 
then type your course 
number and section as 
the Subject property 
(Figure 1–66).

What types of 
document properties 
does PowerPoint 
collect automatically?

PowerPoint records 
such details as how 
long you worked at 
creating your project, 
how many times you 
revised the document, 
and what fonts and 
themes are used.

3

• Click the Close the Document Information Panel button so that the Document Information 
Panel no longer is displayed.

4

Q
&

A

Close the 
Document 
Information 
Panel button

course number 
and section 
entered

student name 
entered
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Moving to Another Slide in Normal View
When creating or editing a presentation in Normal view, you often want to display a slide 
other than the current one. You can move to another slide using several methods.

• Drag the scroll box on the vertical scroll bar up or down to move through the slides 
in the presentation.

• Click the Next Slide or Previous Slide button on the vertical scroll bar. Clicking 
the Next Slide button advances to the next slide in the presentation. Clicking the 
Previous Slide button backs up to the slide preceding the current slide.

• On the Slides tab, click a particular slide to display that slide in the Slide pane.

• Click the Save button on the Quick 
Access Toolbar to overwrite the 
previous Cabo Package fi le on the 
USB fl ash drive (Figure 1–67).

Why did the Save As dialog box not 
appear?

PowerPoint overwrites the document 
using the settings specifi ed the fi rst 
time you saved the document. To save 
the fi le with a different fi le name or 
on different media, display the Save 
As dialog box by clicking the Offi ce 
Button and then clicking Save As on 
the Offi ce Button menu. Then, fi ll in 
the Save As dialog box as described 
in Steps 2 through 5 on pages PPT 27 
through PPT 29.

1

Q
&

A

Figure 1–67

Save button PowerPoint saved 
document with 
same fi le name, 
Cabo Package

1. Press CTRL+S or press 
SHIFT+F12, press ENTER

 

 Other Ways
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To Use the Scroll Box on the Slide Pane to Move to Another Slide

Before continuing with developing this project, you want to display the title slide by dragging the scroll box on 
the vertical scroll bar. When you drag the scroll box, the slide indicator shows the number and title of the slide you 
are about to display. Releasing the mouse button shows the slide. The following steps move from Slide 5 to Slide 1 
using the scroll box on the Slide pane.

• Position the mouse 
pointer on the scroll box.

• Press and hold down 
the mouse button so 
that Slide: 5 of 5 A 
World Beneath the 
Waves appears in 
the slide indicator 
(Figure 1–68).

1

Figure 1–68

• Drag the scroll box 
up the vertical scroll 
bar until Slide: 1 of 5 
A World Beneath the 
Waves appears in 
the slide indicator 
(Figure 1–69).

2

Figure 1–69

vertical scroll bar

scroll box

slide indicator

Previous Slide 
button

Next Slide 
button

Slide 5 has 
an orange 
border

drag scroll 
box up

slide indicator
Slide 5 is 
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Viewing the Presentation in Slide Show View
The Slide Show button, located in the lower-right corner of the PowerPoint window 
above the status bar, allows you to show a presentation using a computer. The computer 
acts like a slide projector, displaying each slide on a full screen. The full-screen slide hides 
the toolbars, menus, and other PowerPoint window elements. 

• Release the mouse button so that 
Slide 1 appears in the Slide pane 
and the Slide 1 thumbnail has an 
orange border in the Slides tab 
(Figure 1–70).

3

Figure 1–70

orange border 
surrounds Slide 1

Slide 1 is 
displayed

Other Ways

1. Click Next Slide button 
or Previous Slide button 
to move forward or 
back one slide

2. Press PAGE DOWN 
or PAGE UP to move 
forward or back 
one slide
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To Start Slide Show View

When making a presentation, you use Slide Show view. You can start Slide Show view from Normal view or Slide 
Sorter view. Slide Show view begins when you click the Slide Show button in the lower-right corner of the PowerPoint 
window on the status bar. PowerPoint then shows the current slide on the full screen without any of the PowerPoint 
window objects, such as the menu bar or toolbars. The following steps start Slide Show view.

• Point to the Slide Show button 
in the lower-right corner of the 
PowerPoint window on the status 
bar (Figure 1–71).

1

Figure 1–71

• Click the Slide Show 
button to display the 
title slide (Figure 1–72).

Where is the 
PowerPoint window? 

When you run a slide 
show, the PowerPoint 
window is hidden. It 
will reappear once you 
end your slide show. 

2

Figure 1–72
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Normal view 
button is 
selected

Slide Show button

title slide 
in Slide 
Show view

Other Ways

1. Click Slide Show tab, 
click From Beginning 
button in Start Slide 
Show group

2. Press F5
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To Move Manually through Slides in a Slide Show

After you begin Slide Show view, you can move forward or backward through the slides. PowerPoint allows 
you to advance through the slides manually or automatically. During a slide show, each slide in the presentation 
shows on the screen, one slide at a time. Each time you click the mouse button, the next slide appears. The following 
steps move manually through the slides.

• Click each slide until 
Slide 5 (A World 
Beneath the Waves) is 
displayed (Figure 1–73).

I see a small toolbar in 
the lower-left corner 
of my slide. What is 
this toolbar?

The Slide Show 
toolbar appears when 
you begin running a 
slide show and then 
move the mouse 
pointer. The buttons 
on this toolbar allow 
you to navigate to the 
next slide, the previ-
ous slide, to mark up 
the current slide, or 
to change the current 
display.

1

Figure 1–73

• Click Slide 5 so that the black slide 
appears with a message announcing 
the end of the slide show 
(Figure 1–74).

How can I end the presentation at 
this point?

Click the black slide to return to 
Normal view in the PowerPoint 
window or press the ESC key.

2
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Figure 1–74

Slide 5  is 
displayed in 
Slide Show view

message 
announces end 
of slide show

1. Press PAGE DOWN to 
advance one slide at a time, 
or press PAGE UP to go back 
one slide at a time

2. Press RIGHT ARROW or DOWN 
ARROW to advance one 
slide at a time, or press LEFT 
ARROW or UP ARROW to go 
back one slide at a time

3. If Slide Show toolbar is 
displayed, click Next Slide 
or Previous Slide button on 
toolbar

Other Ways

Q
&
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To Display the Pop-Up Menu and Go to a Specifi c Slide

Slide Show view has a shortcut menu, called a pop-up menu, that appears when you right-click a slide in 
Slide Show view. This menu contains commands to assist you during a slide show.

When the pop-up menu appears, clicking the Next command moves to the next slide. Clicking the Previous 
command moves to the previous slide. Pointing to the Go to Slide command and then clicking the desired slide 
allows you to move to any slide in the presentation. The Go to Slide submenu contains a list of the slides in the pre-
sentation. You can go to the requested slide by clicking the name of that slide. Additional pop-up menu commands 
allow you to change the mouse pointer to a ballpoint or felt tip pen or highlighter that draws in various colors, make 
the screen black or white, create speaker notes, and end the slide show. The following steps go to the title slide 
(Slide 1) in the Cabo Package presentation.

• With the black slide 
displaying in Slide 
Show view, right-click 
the slide to display the 
pop-up menu.

1

Figure 1–75

• Point to Go to Slide 
on the pop-up menu, 
and then point to 2 
Package Highlights 
in the Go to 
Slide submenu 
(Figure 1–75).

Why does my pop-up 
menu appear in a dif-
ferent location on my 
screen?

The pop-up menu 
appears near the 
location of the mouse 
pointer at the time 
you right-click.  

2
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• Click 2 Package 
Highlights to display 
Slide 2.

3

pop-up menu

Next command

Go to Slide 
command

Go to Slide 
submenu

Slide 2 is 
desired slide

Po
w

er
Po

in
t 

C
h

ap
te

r 
1

Po
w

er
Po

in
t 

C
h

ap
te

r 
1

C6166_PPT_01.4c.indd   51C6166_PPT_01.4c.indd   51 3/7/07   9:59:15 AM3/7/07   9:59:15 AM



PPT 52   PowerPoint Chapter 1   Creating and Editing a Presentation

To Use the Pop-Up Menu to End a Slide Show

The End Show command on the pop-up menu ends Slide Show view and returns to the same view as when 
you clicked the Slide Show button. The following steps end Slide Show view and return to Normal view.

• Right-click Slide 2 and 
then point to End 
Show on the pop-up 
menu (Figure 1–76).

1

Figure 1–76

Quitting PowerPoint
If you have made changes to a presentation since the last time the fi le was saved, PowerPoint 
displays a dialog box asking if you want to save the changes you made to the fi le before it 
closes that window. The dialog box contains three buttons with these resulting actions:

• Yes button — Saves the changes and then quits PowerPoint
• No button — Quits PowerPoint without saving changes
• Cancel button — Closes the dialog box and redisplays the presentation without sav-

ing the changes
If no changes have been made to an open presentation since the last time the fi le 

was saved, PowerPoint will close all windows without displaying any dialog boxes.

End Show 
command

Slide 2  is displayed in 
Slide Show view

• Click End Show 
to return to Slide 2 
in the Slide pane in 
Normal view.

• If the Microsoft Offi ce 
PowerPoint dialog 
box appears, click 
the Yes button.

2

Other Ways

1. Press ESC (shows slide 
last viewed in Slide 
Show view)
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To Quit PowerPoint

You saved the presentation prior to running the slide show and did not make any changes to the project. 
The presentation now is complete, and you are ready to quit PowerPoint. When you have one document open the 
following steps quit PowerPoint.

• Point to the Close button on the 
right side of the PowerPoint title 
bar (Figure 1–77).

1

• Click the Close button to quit 
PowerPoint

2

Starting PowerPoint and Opening a Presentation
Once you have created and saved a presentation, you may need to retrieve it from your 
storage medium. For example, you might want to revise the document or print it. 
Opening a presentation requires that PowerPoint is running on your computer.

Figure 1–77

Close button

1. Double-click Offi ce 
Button

2. Click Offi ce Button, click 
Exit PowerPoint on Offi ce 
Button menu

3. Right-click Microsoft 
PowerPoint button on 
Windows taskbar, click 
Close on shortcut menu

4. Press ALT+F4

Other Ways

To Start PowerPoint

The following steps, which assume Windows is running, start PowerPoint.

Click the Start button on the Windows taskbar to display the Start menu.

Point to All Programs on the Start menu to display the All Programs submenu and then 
point to Microsoft Offi ce on the All Programs submenu to display the Microsoft Offi ce 
submenu.

Click Microsoft Offi ce PowerPoint 2007 on the Microsoft Offi ce submenu to start 
PowerPoint and display a new blank presentation in the PowerPoint window.

If the PowerPoint window is not maximized, click the Maximize button on its title bar to 
maximize the window.
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To Open a Presentation from PowerPoint

Earlier in this chapter you saved your project on a USB fl ash drive using the fi le name, Cabo Package. The 
following steps open the Cabo Package fi le from the USB fl ash drive.

• With your USB fl ash drive 
connected to one of the comput-
er’s USB ports, click the Offi ce 
Button to display the Offi ce 
Button menu (Figure 1–78).

What fi les are shown in the 
Recent Documents list? 

PowerPoint displays the 
most recently opened 
document fi le names in this list. 
If the name of the fi le you want 
to open appears in the Recent 
Documents list, you could click it 
to open the fi le. 

1

Figure 1–78

• Click Open on the Offi ce Button 
menu to display the Open 
dialog box.

• If necessary, click the Look in box 
arrow and then click UDISK 2.0 
(E:) to select the USB fl ash drive, 
Drive E in this case, in the Look in 
list as the new open location.

• Click Cabo Package to select the 
fi le name (Figure 1–79).

How do I open the fi le if I am not 
using a USB fl ash drive?

Use the same process, but be 
certain to select your device in the 
Look in list. 

2

Figure 1–79
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Offi ce 
Button 
menu

Offi ce Button

Open command
Recent Documents 
list displays names 
of recently opened 
PowerPoint fi les

blank Presentation1 is 
opened in Microsoft 
PowerPoint window

selected fi le

USB fl ash 
drive is 
selected 

Look in 
box arrow

Open button
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• Click the Open button to open the 
selected fi le and display Slide 1 in the 
PowerPoint window (Figure 1–80).

Why do I see the PowerPoint icon 
and name on the Windows taskbar? 

When you open a PowerPoint fi le, 
a PowerPoint program button is 
displayed on the taskbar. The button 
contains an ellipsis because some of 
its contents do not fi t in the allot-
ted button space. If you point to a 
program button, its entire contents 
appear in a ScreenTip, which in this 
case would be the program name 
followed by the fi le name. 

3

Figure 1–80

Checking a Presentation for Spelling Errors
After you create a presentation, you should check it visually for spelling errors and style 
consistency. In addition, you use PowerPoint’s Spelling tool to identify possible misspell-
ings. Do not rely on the spelling checker to catch all your mistakes. While PowerPoint’s 
spelling checker is a valuable tool, it is not infallible. You should proofread your presenta-
tion carefully by pointing to each word and saying it aloud as you point to it. Be mindful 
of commonly misused words such as its and it’s, through and though, and to and too.

PowerPoint checks the entire presentation for spelling mistakes using a standard 
dictionary contained in the Microsoft Offi ce group. This dictionary is shared with the 
other Microsoft Offi ce applications such as Word and Excel. A custom dictionary is 
available if you want to add special words such as proper names, cities, and acronyms. 
When checking a presentation for spelling errors, PowerPoint opens the standard dic-
tionary and the custom dictionary fi le, if one exists. When a word appears in the Spelling 
dialog box, you can perform one of several actions.

Q
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A

Slide 1 appears in 
Slide pane and on 
Slides tab

title of saved 
document is 
displayed on 
title bar

Other Ways

1. Click Offi ce Button, 
double-click fi le 
name in Recent 
Documents list

2. Press CTRL+O, select fi le 
name, press ENTER
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To Check Spelling

The standard dictionary contains commonly used English words. It does not, however, contain many proper 
names, abbreviations, technical terms, poetic contractions, or antiquated terms. PowerPoint treats words not 
found in the dictionaries as misspellings. The following steps check the spelling on all slides in the Cabo Package 
presentation.

• Click Review on the Ribbon to display 
the Review tab (Figure 1–81).

1

Figure 1–81

Review tab

Table 1–1 Spelling Dialog Box Buttons and Actions

Button Name When To Use Action

Ignore Word is spelled correctly but 
not found in dictionaries

Continues checking rest of the presentation but will fl ag 
that word again if it appears later in document

Ignore All Word is spelled correctly but 
not found in dictionaries

Ignores all occurrences of the word and continues checking 
rest of presentation

Change Word is misspelled Click proper spelling of the word in Suggestions list. 
PowerPoint corrects word, continues checking rest of 
presentation, but will fl ag that word again if it appears later 
in document.

Change All Word is misspelled Click proper spelling of word in Suggestions list. PowerPoint 
changes all occurrences of misspelled word and continues 
checking rest of presentation.

Add Add word to custom dictionary PowerPoint opens custom dictionary, adds word, and 
continues checking rest of presentation.

Suggest Correct spelling is uncertain Lists alternative spellings. Click the correct word from the 
Suggestions box or type the proper spelling. Corrects the 
word and continues checking the rest of the presentation.

AutoCorrect Add spelling error to 
AutoCorrect list

PowerPoint adds spelling error and its correction to 
AutoCorrect list. Any future misspelling of word is corrected 
automatically as you type.

Close Stop spelling checker PowerPoint closes spelling checker and returns to 
PowerPoint window.
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• Click the Spelling button 
in the Proofi ng group to 
start the spelling checker 
and display the Spelling 
dialog box (Figure 1–82).

2

Figure 1–82

• Click the Ignore button 
to skip the word, Cabo 
(Figure 1–83).

Cabo is not fl agged as 
a possible misspelled 
word. Why not? 

Your custom dictionary 
contains the word, so 
it is recognized as a 
correct word.
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Figure 1–83
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fl agged word 
appears in Not in 
Dictionary box as 
possible misspelling

Ignore 
button skips 
one word

fl agged word 
appears in Not in 
Dictionary box as 
possible misspelling

red wavy line removed 
because PowerPoint now 
ignores the word, Cabo
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Correcting Errors
After creating a presentation and running the spelling checker, you may fi nd that you must 
make changes. Changes may be required because a slide contains an error, the scope of 
the presentation shifts, or the style is inconsistent. This section explains the types of errors 
that commonly occur when creating a presentation.

Types of Corrections Made to Presentations
You generally make three types of corrections to text in a presentation: additions, 

deletions, and replacements.

• Additions are necessary when you omit text from a slide and need to add it later. 
You may need to insert text in the form of a sentence, word, or single character. For 
example, you may want to add the presenter’s middle name on the title slide.

• Deletions are required when text on a slide is incorrect or no longer is relevant to the 
presentation. For example, a slide may look cluttered. Therefore, you may want to 
remove one of the bulleted paragraphs to add more space.

• Replacements are needed when you want to revise the text in a presentation. For 
example, you may want to substitute the word, their, for the word, there.

Editing text in PowerPoint basically is the same as editing text in a word processing 
program. The following sections illustrate the most common changes made to text in a 
presentation.

Deleting Text
You can delete text using one of three methods. One is to use the BACKSPACE key to 

remove text just typed. The second is to position the insertion point to the left of the text 
you wish to delete and then press the DELETE key. The third method is to drag through 
the text you wish to delete and then press the DELETE key. Use the third method when 
deleting large sections of text.

Figure 1–84

• Click the Ignore button to skip the 
word, Ehlin.

• When the Microsoft Offi ce 
PowerPoint dialog box appears, click 
the OK button to close the spelling 
checker and return to the current 
slide, Slide 1, or to the slide where a 
possible misspelled word appeared.

• Click the slide to remove the box 
from the word, Ehlin (Figure 1–84).

4

red wavy line removed 
because PowerPoint now 
ignores the word, Ehlin

Other Ways

1. Press F7

Certifi cation
The Microsoft Certifi ed 
Application Specialist 
(MCAS) program provides 
an opportunity for you 
to obtain a valuable 
industry credential – 
proof that you have the 
PowerPoint 2007 skills 
required by employers. 
For more information 
see Appendix F or visit 
the PowerPoint 2007 
Certifi cation Web page 
(scsite.com/ppt2007/cert).

B
T
W

C6166_PPT_01.4c.indd   58C6166_PPT_01.4c.indd   58 3/7/07   9:59:28 AM3/7/07   9:59:28 AM



Displaying a Presentation in Grayscale   PPT 59

Replacing Text in an Existing Slide
When you need to correct a word or phrase, you can replace the text by selecting 

the text to be replaced and then typing the new text. As soon as you press any key on the 
keyboard, the selected text is deleted and the new text is displayed.

PowerPoint inserts text to the left of the insertion point. The text to the right of the 
insertion point moves to the right (and shifts downward if necessary) to accommodate the 
added text.

Displaying a Presentation in Grayscale
Printing handouts of a presentation allows you to use them to make overhead transparencies. 
The Color/Grayscale button on the Color/Grayscale group on the View tab shows the pre-
sentation in black and white before you print. Pure Black and White alters the slides’ appear-
ance so that black lines display on a white background. Shadows and other graphical effects 
are hidden. Grayscale shows varying degrees of gray.

To Display a Presentation in Grayscale

The Color/Grayscale button on the Color/Grayscale group on the View tab changes from color bars to shades 
of black, called grayscale, and white. After you view the text objects in the presentation in grayscale, you can make 
any changes that will enhance printouts produced from a black and white printer or photocopier. The following 
steps display the presentation in grayscale.

• Click View on the Ribbon to display 
the View tab (Figure 1–85).

1

Figure 1–85
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Figure 1–86

• Click Grayscale in the Color/Grayscale 
group to display Slide 1 in grayscale 
in the Slide pane (Figure 1–86).

2

• Click the Next Slide button four times 
to view all slides in the presentation 
in grayscale (Figure 1–87).

3

Figure 1–87

Slide 1 is 
displayed in 
Grayscale view

Slide 5 is 
displayed in 
Grayscale view

Next Slide button

Back To Color 
View button
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Printing a Presentation
After you create a presentation, you often want to print it. A printed version of the 
presentation is called a hard copy or printout.

Printed copies of your presentation can be useful for the following reasons:

• Many people prefer proofreading a hard copy of the presentation rather than viewing 
the slides on the screen to check for errors and readability.

• Someone without computer access or who could not attend your live presentation 
can view the slides’ content.

• Copies can be distributed as handouts to people viewing your presentation.
• Hard copies can serve as reference material if your storage medium is lost or becomes 

corrupted and you need to re-create the presentation. 
It is a good practice to save a presentation before printing it, in the event you 

experience diffi culties with the printer.

• Click the Back To Color View button 
in the Close group to return to the 
previous tab and display Slide 5 
with the default Flow color scheme 
(Figure 1–88).

4 

Figure 1–88

Slide 5 is 
displayed 
in color

To Print a Presentation

With the completed presentation saved, you may want to print it. The following steps print all fi ve completed 
presentation slides in the saved Cabo Package project.

Figure 1–89

• Click the Offi ce Button to display 
the Offi ce Button menu.

• Point to Print on the Offi ce 
Button menu to display the Print 
submenu (Figure 1–89).

Can I print my presentation in 
black and white to conserve ink or 
toner? 

Yes. Click the Offi ce Button, point 
to the arrow next to Print on the 
Offi ce Button menu, and then 
click Print Preview on the Print 
submenu. Click the Options button 
on the Print Preview tab, point to 
Color/Grayscale on the Options button menu, and then click Pure Black and White on the 
Color/Grayscale submenu. Click the Print button on the Print submenu. 

1

Q
&

A

Quick Print 
button prints 
slides directly

clicking Print 
button displays 
Print submenu

Print 
submenu
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• Click Quick Print on 
the Print submenu to 
print the slides.

• When the printer 
stops, retrieve the hard 
copy of the fi ve Cabo 
Package slides (Figures 
1–90a through 1–90e).

How can I print multiple 
copies of my document 
other than clicking the 
Print button twice? 

Click the Offi ce Button, 
point to Print on the 
Offi ce Button menu, 
click Print on the Print 
submenu, increase the 
number in the Number 
of copies box, and then 
click the OK button.

Do I have to wait until 
my presentation is 
complete to print it? 

No, you can follow 
these steps  to print 
your slides at any time 
while you are creating 
your presentation.

2

(a) Slide 1 (b) Slide 2

(c) Slide 3 (d) Slide 4

(e) Slide 5

Figure 1–90

Q
&

A
Q

&
A

Making a Transparency
With the handouts printed, you now can make overhead transparencies using one of 

several devices. One device is a printer attached to your computer, such as an inkjet printer 
or a laser printer. Transparencies produced on a printer may be in black and white or color, 
depending on the printer. Another device is a photocopier. Because each of these devices 
requires a special transparency fi lm, check the user’s manual for the fi lm requirement of 
your specifi c device, or ask your instructor.

Other Ways

1. Press CTRL+P

Quick Reference
For a table that lists how 
to complete the tasks 
covered in this book 
using the mouse, Ribbon, 
shortcut menu, and 
keyboard, see the Quick 
Reference Summary at 
the back of this book, or 
visit the PowerPoint 2007 
Quick Reference Web 
page (scsite.com/
ppt2007/qr).

B
T
W
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PowerPoint Help
At any time while using PowerPoint, you can fi nd answers to questions and display 
information about various topics through PowerPoint Help. Used properly, this form 
of assistance can increase your productivity and reduce your frustrations by minimizing 
the time you spend learning how to use PowerPoint.

This section introduces you to PowerPoint Help. Additional information about 
using PowerPoint Help is available in Appendix C.

To Search for PowerPoint Help

Using PowerPoint Help, you can search for information based on phrases such as save a presentation or format 
a chart, or key terms such as copy, save, or format. PowerPoint Help responds with a list of search results displayed as 
links to a variety of resources. The following steps, which use PowerPoint Help to search for information about using 
document themes, assume you are connected to the Internet.

• Click the Microsoft 
Offi ce PowerPoint Help 
button near the up-
per right-corner of the 
PowerPoint window 
to open the PowerPoint 
Help window.

• Type document theme 
in the Type words to 
search for text box 
at the top of the 
PowerPoint Help 
window (Figure 1–91).

1

Figure 1–91

PowerPoint Help window 
allows you to search for 
information based on 
phrases or key terms

Type words 
to search for 
text box

Maximize 
button

Microsoft Offi ce 
PowerPoint 
Help button

PowerPoint Help
The best way to 
become familiar with 
PowerPoint Help is to use 
it. Appendix C includes 
detailed information 
about PowerPoint Help 
and exercises that will 
help you gain confi dence 
in using it.
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• Press the ENTER key 
to display the search 
results. 

• Click the 
Maximize 
button on the 
PowerPoint Help 
window title bar to 
maximize the Help 
window (Figure 1–92).

Where is the PowerPoint 
window with Slide 1? 

PowerPoint is open in 
the background, but 
the PowerPoint Help 
window is overlaid on 
top of the Microsoft 
PowerPoint window. 
When the PowerPoint 
Help window is closed, 
the slide will reappear. 

2

Q
&

A

Figure 1–92

Figure 1–93

• Click the ‘Apply or 
customize a document 
theme’ link to display 
information regarding 
applying or customizing 
themes (Figure 1–93).

What is the purpose 
of the buttons at the 
top of the PowerPoint 
Help window? 

Use the buttons in the 
upper-left corner of 
the PowerPoint Help 
window to navigate 
through the Help sys-
tem, change the display, 
show the PowerPoint 
Help table of contents, 
and print the contents 
of the window. 

3

Q
&

A

• Click the Close button on the PowerPoint Help window title bar to close the PowerPoint Help  
window and display Slide 5.

4

clicking these links 
will display other 
pages with links about 
document themes

search results 
display different 
icons, depending 
on type of link

fi rst 25 results 
of search are 
displayed

Apply or 
customize a 
document 
theme link

PowerPoint 
Help window 
maximized

Back, Forward, 
Stop, Refresh, and 
Home buttons

Print button

Close 
button

Other Ways

1. Press F1

PowerPoint 
window in 
background
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To Quit PowerPoint

The following steps quit PowerPoint.

Click the Close button on the right side of the title bar to quit PowerPoint.

If necessary, click the ‘No button in the Microsoft Offi ce PowerPoint’ dialog box so that 
any changes you have made are not saved.

1

2

Chapter Summary
In this chapter you have learned how to apply a document theme, create a title slide and text slides with bulleted 
lists, format text, view the presentation in Slide Show view, and print slides as handouts. The items listed below 
include all the new PowerPoint skills you have learned in this chapter.

 1. Start PowerPoint (PPT 5)
 2. Choose a Document Theme (PPT 16)
 3. Enter the Presentation Title (PPT 18)
 4. Enter the Presentation Subtitle Paragraph (PPT 20)
 5. Select a Paragraph (PPT 21)
 6. Italicize Text (PPT 22)
 7. Select Multiple Paragraphs (PPT 22)
 8. Change the Text Color (PPT 23)
 9. Select a Group of Words (PPT 24)
 10. Increase Font Size (PPT 24)
 11. Bold Text (PPT 25)
 12. Decrease the Title Slide Title Text Font Size 

(PPT 25)
 13. Save a Presentation (PPT 27)
 14. Add a New Text Slide with a Bulleted List 

(PPT 29)
 15. Enter a Slide Title (PPT 31)
 16. Select a Text Placeholder (PPT 31)
 17. Type a Single-Level Bulleted List (PPT 32)
 18. Add a New Slide and Enter a Slide Title (PPT 33)
 19. Type a Multi-Level Bulleted List (PPT 34)
 20. Create a Third-Level Paragraph (PPT 37)

 21. Duplicate a Slide (PPT 40)
 22. Arrange a Slide (PPT 41)
 23. Delete All Text in a Placeholder (PPT 42)
 24. Change Document Properties (PPT 44)
 25. Save an Existing Presentation with the Same File 

Name (PPT 45)
 26. Use the Scroll Box on the Slide Pane to Move to 

Another Slide (PPT 47)
 27. Start Slide Show View (PPT 49)
 28. Move Manually through Slides in a Slide Show 

(PPT 50)
 29. Display the Pop-Up Menu and Go to a Specifi c 

Slide (PPT 51)
 30. Use the Pop-Up Menu to End a Slide Show 

(PPT 52)
 31. Quit PowerPoint (PPT 53)
 32. Open a Presentation from PowerPoint (PPT 54)
 33. Check Spelling (PPT 55)
 34. Display a Presentation in Grayscale (PPT 59)
 35. Print a Presentation (PPT 61)
 36. Search for PowerPoint Help (PPT 63)

If you have a SAM user profi le, you may have access to hands-on instruction, practice, and 
assessment. Log in to your SAM account (http://sam2007.course.com) to launch any assigned 
training activities or exams that relate to the skills covered in this chapter.
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Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short 
answer questions that test your knowledge of the 
chapter content.

Flash Cards
An interactive learning environment where 
you identify chapter key terms associated with 
displayed defi nitions.

Practice Test
A series of multiple choice questions that test your 
knowledge of chapter content and key terms.

Who Wants To Be a Computer Genius?
An interactive game that challenges your 
knowledge of chapter content in the style of a 
television quiz show.

Wheel of Terms
An interactive game that challenges your 
knowledge of chapter key terms in the style of the 
television show Wheel of Fortune.

Crossword Puzzle Challenge
A crossword puzzle that challenges your 
knowledge of key terms presented in the chapter.

Apply Your Knowledge 

Reinforce the skills and apply the concepts you learned in this chapter.

Modifying Character Formats and Paragraph Levels
Instructions: Start PowerPoint. Open the presentation, Apply 1-1 Keep Your Cool, from the Data Files 
for Students. See the inside back cover of this book for instructions on downloading the Data Files for 
Students, or contact your instructor for more information about accessing the required fi les.

The two slides in the presentation stress the importance of drinking plenty of water on hot days. 
The document you open is an unformatted presentation. You are to modify the document theme and 
text, indent the paragraphs, and format the text so the slides look like Figure 1–94.

Perform the following tasks:
 1. Change the document 

theme to Trek. Note that 
the Trek theme uses all 
capital letters for the title 
text. On the title slide, 
use your name in place of 
Student Name and bold 
and italicize your name. 
Increase the title text font 
size to 44 point.

Learn It Online

Test your knowledge of chapter content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and 
then enter the Web address scsite.com/ppt2007/learn. When the Offi ce 2007 Learn It Online 
page is displayed, click the link for the exercise you want to complete and then read the instructions.

(a) Slide 1 (Title Slide)

44-point 
font size

Trek 
document 
theme

bold and 
italicize name

substitute 
your name

Figure 1–94
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 2.  On Slide 2, increase the indent 
of the second, fi fth, and sixth 
paragraphs (Drink throughout the 
day; Do not substitute caffeinated 
beverages; Cool water is best for 
keeping hydrated) to second-
level paragraphs. Then change 
paragraphs three and four (Start 
and end your day with water; Do 
not wait until you are thirsty) to 
third-level paragraphs.

 3.  Check the spelling, and then 
display the revised presentation in 
grayscale.

 4.  Change the document properties, 
as specifi ed by your instructor. 
Save the presentation using the 
fi le name, Apply 1-1 Drink Water. 
Submit the revised document 
in the format specifi ed by your 
instructor.

(b) Slide 2 (Multi-Level Bulleted List)

Figure 1–94 (continued)

second-level 
paragraph

third-level 
paragraphs
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Perform the following tasks:
 1.  Apply an appropriate document 

theme.

 2.  On Slide 1, use your name in place 
of Student Name. Format the 
text using techniques you learned 
in this chapter, such as changing 
the font size and color and also 
bolding and italicizing words.

Extend Your Knowledge

Extend the skills you learned in this chapter and experiment with new skills. You may need to 
use Help to complete the assignment.

Changing Slide Theme and Text
Instructions: Start PowerPoint. Open the presentation, Extend 1-1 Nutrition, from the Data Files for 
Students. See the inside back cover of this book for instructions on downloading the Data Files for 
Students, or contact your instructor for more information about accessing the required fi les.

You will choose a theme (Figure 1–95), format slides, and create a closing slide.

Figure 1–95

choose a document 
theme from the 
built-in gallery

Continued >
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 3. On Slide 2, adjust the paragraph levels so that the lines of text are arranged under vegetable and fruit 
categories. Edit the text so that the slide meets the 7 � 7 rule, which states that each line should have a 
maximum of seven words, and each slide should have a maximum of seven lines.

 4. On Slides 3 and 4, create paragraphs and adjust the paragraph levels.

 5. Create an appropriate closing slide using the title slide as a guide.

 6. Change the document properties, as specifi ed by your instructor. Save the presentation using the 
fi le name, Extend 1-1 Fruit and Vegetables.

 7. Add the Print button to the Quick Access Toolbar and then click this button to print the slides.

 8. Delete the Print button from the Quick Access Toolbar.

 9. Submit the revised document in the format specifi ed by your instructor.

Make It Right

Analyze a presentation and correct all errors and/or improve the design.

Correcting Formatting and List Levels
Instructions: Start PowerPoint. Open the presentation, Make It Right 1-1 Indulge, from the Data Files 
for Students. See the inside back cover of this book for instructions on downloading the Data Files for 
Students, or contact your instructor for more information about accessing the required fi les.

Correct the formatting problems and errors in the presentation while keeping in mind the guide-
lines presented in this chapter.

Perform the following tasks:
 1.  Change the document theme from 

Metro, shown in Figure 1–96, to 
Opulent.

 2.  On Slide 1, replace the words, Fall 
Semester, with your name. Format your 
name so that it displays prominently on 
the slide.

 3.  Move Slide 2 to the end of the 
presentation so that it becomes the new 
Slide 4.

 4.  Use the spell checker to correct the 
misspellings. Analyze the slides for 
other word usage errors that the spell 
checker did not fi nd.

 5. On Slide 2, increase the Slide 2 title (Athletic Events) font size to 40. Make the indent levels for 
paragraphs 2, 4, and 6 the same level.

 6. On Slide 3, change the title text (Awards Ceremony) font size to 40. Make the indent levels for 
paragraphs 3 and 5 the same level.

 7. Change the document properties, as specifi ed by your instructor. Save the presentation using the 
fi le name, Make It Right 1-1 Intramurals.

 8. Submit the revised document in the format specifi ed by your instructor.

Extend Your Knowledge continued

Figure 1–96

change document 
theme to Opulent

substitute your 
name, and then 
format the text
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In the Lab

Design and/or create a presentation using the guidelines, concepts, and skills presented in this 
chapter. Labs 1, 2, and 3 are listed in order of increasing diffi culty.

Lab 1: Creating a Presentation 
with Bulleted Lists
Problem: Many of the important 
steps you will take in your life are 
infl uenced by your credit report. 
Buying a car, renting an apartment, 
and even applying for a job often 
require a credit check. Your credit 
score can make or break your ability 
to obtain the goods you truly want 
and need. One of your assignments 
in your economics class is to give 
a speech about establishing credit. 
You develop the outline shown in 
Figure 1–97 and then prepare the 
PowerPoint presentation shown in 
Figures 1–98a through 1–98d.

Instructions: Perform the 
following tasks.
 1.  Create a new presentation using 

the Aspect document theme.
 2.  Using the typed notes 

illustrated in Figure 1–97, 
create the title slide shown in 
Figure 1–98a using your name 
in place of Marc Kantlon. 
Italicize your name. Decrease 
the font size of the title paragraph, 
Give Yourself Some Credit, to 40. Increase the font size of the fi rst paragraph of the subtitle text, 
Understanding Your Credit Report, to 28.

 3.  Using the typed notes in Figure 1–97, create the three text slides with bulleted lists shown in 
Figures 1–98b through 1–98d.

Figure 1–97

In the Lab   PPT 69
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Continued >
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 4.  On Slide 3, change the font color of the number, 760, to green and the number, 620, to red.

 5.  Check the spelling and correct any errors.

 6.  Drag the scroll box to display Slide 1. Click the Slide Show button to start Slide Show view. Then 
click to display each slide.

 7. Change the document properties, as specifi ed by your instructor. Save the presentation using the 
fi le name, Lab 1-1 Credit.

 8. Submit the document in the format specifi ed by your instructor.

(a) Slide 1 (Title Slide)

Aspect 
document 
theme

40-point 
font size

28-point 
font size substitute 

your name

italicized 
name

(b) Slide 2

In the Lab continued

Figure 1–98
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(c) Slide 3

green 
font color

red font 
color

(d) Slide 4
Figure 1–98 (continued)

In the Lab

Lab 2: Creating a Presentation with Bulleted Lists and a Closing Slide
Problem: Hybrid vehicles 
have received much attention 
in recent years. Everyone from 
environmentalists to movie stars 
are driving them, and potential 
buyers wait for months until 
the vehicles arrive in dealers’ 
showrooms. You work part-time 
at Midwest State Bank, and the 
loan department manager, Jen 
Westbrook, has asked you to 
develop a PowerPoint presentation 
to accompany her upcoming 
speech. She hands you the outline 
shown in Figure 1–99 and asks you 
to create the presentation shown in 
Figures 1–100a through 1–100e.

Figure 1–99
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Instructions: Perform the 
following tasks.
 1.  Create a new presentation 

using the Currency 
document theme.

 2.  Using the typed notes 
illustrated in Figure 1–99, 
create the title slide shown 
in Figure 1–100a using 
your name in place of Jan 
Westbrook. Bold your name. 
Italicize the title, Is a Hybrid 
Car Right for You?, and 
decrease the font size to 40. 
Change the font color of the 
title text to green and the 
subtitle text to yellow. 

 3.  Using the typed notes in 
Figure 1–99, create the three 
text slides with bulleted lists 
shown in Figures 1–100b 
through 1–100d. Change the 
color of all the bulleted list 
paragraph text to yellow.

 4.  Duplicate the title slide and 
then move the new closing 
slide to the end of the 
presentation. Change the 
Slide 5 title text, decrease the 
font size to 32, and remove the 
italics.

 5.  Check the spelling and 
correct any errors.

 6.  Drag the scroll box to display 
Slide 1. Click the Slide Show 
button to start Slide Show 
view. Then click to display 
each slide.

 7. Change the document properties, as specifi ed by your instructor. Save the presentation using the 
fi le name, Lab 1-2 Hybrids.

 8. Submit the revised document in the format specifi ed by your instructor.

(a) Slide 1 (Title Slide)

Currency
document
theme

substitute 
your name

yellow 
font color

bold
text

40-point 
font sizeitalic

text

green 
font color

In the Lab continued

(b) Slide 2

yellow 
font color

Figure 1–100

C6166_PPT_01.4c.indd   72C6166_PPT_01.4c.indd   72 3/7/07   10:00:06 AM3/7/07   10:00:06 AM



(c) Slide 3

yellow 
font color

(d) Slide 4

yellow 
font color

Figure 1–100 (continued)

(e) Slide 5 (Closing Slide)

new 
closing
slide32-point 

font size

text not 
italicized
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In the Lab

Lab 3: Creating and Updating Presentations
Problem: Bobbie Willis, the public relations director for the South Haven Park District, plans 
activities every season for community residents and promotes the offerings using a PowerPoint 
presentation. The new seminars for senior citizens this spring are quilting and t’ai chi. Adults can 
register for gourmet cooking lessons and kickball. Teens can enroll in sailing and fencing lessons.

Instructions Part 1: Using the 
outline in Figure 1–101, create 
the presentation shown in 
Figure 1–102. Use the Oriel 
document theme. On the title slide 
shown in Figure 1–102a, type your 
name in place of Bobbie Willis, 
increase the font size of the title 
paragraph, South Haven Park 
District, to 60 and change the text 
font style to italic. Increase the 
font size of the subtitle paragraph, 
New Spring Seminars, to 32, and 
change the font size of the subtitle 
paragraph with your name to 37 
or to a size that displays all the text 
on one line. Create the three text 
slides with multi-level bulleted lists 
shown in Figures 1–102b through 
1–102d.

Correct any spelling mistakes. 
 Change the document properties, 
as specifi ed by your instructor. Save 
the presentation using the fi le 
name, Lab 1-3 Part One Spring 
Seminars. Display the presentation 
in grayscale. 

Figure 1–101

Oriel 
document 
theme

(a) Slide 1 (Title Slide)

italic
text

60-point 
font size

32-point 
font size

substitute 
your name

Figure 1–102
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(b) Slide 2

(d) Slide 4

Figure 1–102 (continued)

In the Lab   PPT 75

Po
w

er
Po

in
t 

  
C

h
ap

te
r 

1
S

T
U

D
E

N
T
  

A
S

S
IG

N
M

E
N

T
S

Continued >

(c) Slide 3

Instructions Part 2: The South Haven Park District staff members want to update this presentation to 
promote the new Fall seminars. Modify the presentation created in Part 1 to create the presentation 
shown in Figure 1–103. Change the document theme to Civic. On the title slide, remove the italics 
from the title paragraph, South Haven Park District, decrease the font size to 44, and bold the text. 
Change the fi rst subtitle paragraph to New Fall Seminars. Then change your title in the second subtitle 
paragraph to Executive Director and change the font size of the entire paragraph to 28.

On Slide 2, change the fi rst fi rst-level paragraph, Quilting, to Quilting for the Holidays. Change 
the fi rst second-level paragraph, Quilts made from donated fabrics, to Quilts will be raffl ed at Annual 
Bazaar. Change the title of the second seminar to Intermediate T’ai Chi.

On Slide 3, change the fi rst second-level paragraph under Almost Gourmet to Holiday feasts 
and parties. Then change the second-level paragraph under Kickball to Seminar concludes with single 
elimination tournament.

On Slide 4, change the fi rst class from Sailing to Climbing and then change the course description 
second-level paragraph to Covers verbal signals, rope, knots, harnesses, belaying.
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PPT 76   PowerPoint Chapter 1   Creating and Editing a Presentation

Correct any spelling mistakes, and then view the slide show. Change the document properties, as 
specifi ed by your instructor. Save the presentation using the fi le name, Lab 1-3 Part Two Fall Seminars. 
Display the presentation in grayscale. Submit both Part One and Part Two documents in the format 
specifi ed by your instructor.

(a) Slide 1 (Title Slide)

Civic 
document 
theme

bold
text

revised 
paragraph 
text

28-point 
font size

44-point 
font size

text not 
italicized

In the Lab continued

(b) Slide 2

revised 
paragraph 
text

Figure 1–103
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(c) Slide 3

revised 
paragraph 
text

(d) Slide 4

Figure 1–103 (continued)

revised 
paragraph 
text
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PPT 78   PowerPoint Chapter 1   Creating and Editing a Presentation

Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution.

• EASIER    •• MORE DIFFICULT

Note: Remember to use the 7 � 7 rule as you design the presentations: a maximum of seven 
words on a line and a maximum of seven lines on one slide.

• 1: Design and Create an Ocean and Seas Presentation
Salt water covers more than two-thirds of the Earth’s surface. This water fl ows freely between 
the Earth’s fi ve oceans and seas, which all are connected. In preparation for your next snorkeling 
and diving adventure, you have been reading about the oceans and seas. You decide to prepare a 
PowerPoint presentation to accompany a speech that is required in your Earth Science class. You 
create the outline shown in Figure 1–104 about these waters. Use this outline along with the concepts 
and techniques presented in this chapter to develop and format a slide show with a title slide and three 
text slides with bulleted lists. Be sure to check spelling.

Figure 1–104
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• 2: Design and Create an Industrial Revolution Presentation
The Industrial Revolution changed the way people worked and lived in many parts of the world. With 
its roots in Britain in the 18th century, the Industrial Revolution introduced new machines, steam power, 
and trains. As part of your World History homework assignments, you develop the outline shown in 
Figure 1–105 about the Industrial Revolution and then create an accompanying PowerPoint presentation. 
Use the concepts and techniques presented in this chapter to develop and format this slide show with a 
title slide, three text slides with bulleted lists, and a closing slide. Be sure to check spelling.

Continued >

Cases and Places   PPT 79

Po
w

er
Po

in
t 

  
C

h
ap

te
r 

1
S

T
U

D
E

N
T
  

A
S

S
IG

N
M

E
N

T
S

Figure 1–105
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PPT 80   PowerPoint Chapter 1   Creating and Editing a Presentation

•• 3: Design and Create a Recycling Presentation
Many communities require recycling of household waste. Residents are required to separate paper, 
plastics, and glass and put each material in special bins or bags. Electronic equipment also can be 
recycled. Your community has developed a special program for broken or obsolete computers and 
peripherals, offi ce equipment and products, small home appliances, and entertainment equipment. 
These items include personal computers, printers, cellular telephones, toasters, televisions, DVD 
players, and video game consoles. Community offi cials will be collecting these items during the 
next two Fridays at your local police station and a nearby shopping center. They will not accept air 
conditioners, humidifi ers, and hazardous wastes. Using the concepts and techniques presented in 
this chapter, develop a short PowerPoint presentation to show at various businesses and offi ces in 
your community. Emphasize that recycling is important because electronic products have very short 
useful lives. They produce waste and may contain hazardous materials, but many components can be 
salvaged. Include one slide with acceptable products and another with unacceptable products.

•• 4 Design and Create Your Favorite or Dream Car Presentation

Make It Personal
Ever since Henry Ford rolled the fi rst Model T off his assembly line in 1908, people have been 
obsessed with cars. From the sporty Corvette to the environmentally friendly Prius, everyone has a 
favorite car or dream car. Use the concepts and techniques presented in this chapter to create a slide 
show promoting a particular vehicle. Include a title slide, at least three text slides with bulleted lists, 
and a closing slide. Format the text using colors, bolding, and italics where needed for emphasis. Be 
sure to check spelling.

•• 5: Design and Create a Financial Institutions Presentation

Working Together
Financial institutions such as banks, savings and loans, and credit unions offer a variety of products. 
Have each member of your team visit, telephone, or view Web sites of three local fi nancial institutions. 
Gather data about:
 1) Savings accounts

 2) Checking accounts

 3) Mortgages

 4) Certifi cates of deposit
After coordinating the data, create a presentation with at least one slide showcasing each fi nancial 
institution. As a group, critique each slide. Submit your assignment in the format specifi ed by your 
instructor.

Cases and Places  continued

C6166_PPT_01.4c.indd   80C6166_PPT_01.4c.indd   80 3/7/07   10:00:28 AM3/7/07   10:00:28 AM


